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This is a practical guide for applying modern methods and approaches 

for measuring and analysis of the acoustic parameters in mammal and 
bird calls, along to principles of their recording in the field or under 
laboratory conditions. This guide contains a few practical tasks for call 
measuring and the comparative analysis of their acoustic variation. The 
practical tasks, containing detailed guidelines and comments, would 
help students to know more about the actual problems of bioacoustical 
research on particular examples during their individual work. The prac-
tical tasks are presented in the order as they should be fulfilled during 
the practical part of the «Bioacoustics of vertebrates» teaching course of 
the Department of Vertebrate Zoology, Faculty of Biology, Lomonosov 
Moscow State University, Moscow, Russia.
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Introduction. 
Essential terms and definitions of 

bioacoustics

What are animal calls and which main approaches 
can be used for their description and analysis

Everyday experience suggests that any sound can be described using 
three main parameters: duration (long or short), pitch (perceived by 
researcher call frequency characteristics) and loudness (perceived by 
researcher call intensity). For example, dog bark is short, low-frequency 
and loud, whereas dog whine is long, high-frequency and faint. These 
three groups of parameters are essential for describing the acoustic 
structure of any animal call.

Sounds are waves in their nature. Sound wave, as any oscillatory 
process, can be described via a combination of simple characteristics. 
Sound wave can be visualized with different ways by computer soft-
ware.

How to measure call duration?
The simplest way to visualize sound is the oscillogram (= waveform), 

that graphically represents the relationship of call amplitude from time 
(Fig. 1). Oscillogram enables to measure the amplitude of sound wave 
and the oscillation period (T), the time space, during which the wave 
passes the entire cycle. Call fundamental frequency (= rate of oscilla-
tions) is the inverse value to the oscillation period f=1/T. The large 
oscillation period corresponds to the low values of call fundamental 
frequency, whereas the short oscillation period corresponds to its high 
values. By oscillogram, we can measure the entire call duration and 
sometimes also estimate call fundamental frequency (although it is dif-
ficult in most cases).

How to measure call fundamental frequency?
Any wave process can be presented as time-frequency spectrum using 

Fast Fourier Transform (FFT), the mathematical algorithm developed 
by Jean Baptiste Fourier at the beginning of 19th century. The FFT algo-
rithm presents a time function as a sum of separate sinusoid and cosine 
waves with different amplitudes and frequencies, where spectrum of 
the summary function is equal to the sum of spectra of its’ harmonic 
components. The FFT strongly simplifies the sound image, and enables 
to measure call frequency parameters.
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Relationship between call frequency and time, created by FFT, is call 
spectrogram (Fig. 1). The unit for measuring call fundamental frequen-
cy is Hertz. One Hertz (1 Hz) is one sound wave oscillation per second; 
one kiloHertz (1000 Hz) is one thousand oscillations per second. Men’s 
voice fundamental frequency is about 150–200 Hertz. In addition to the 
fundamental frequency, the spectrogram, as oscillogram, enables mea-
suring the duration of entire calls or call parts (e.g., from the beginning 
of a call to its frequency maximum or from the maximum to the end of a 
call). Spectrogram is more informative than oscillogram.

How to measure call intensity?
Call intensity is determined by sound wave amplitude. On spectro-

gram, sound energy and, respectively, sound amplitude at particular 
frequency is as higher, as it is darker (blacker). Another way of sound 
visualization is power spectrum, displaying the dependence of intensity 
from call frequency, either at particular point of a call (single spectrum) 
or over the entire call duration (overall spectrum) (Fig. 1).

In contrast to call duration and frequency, which are absolute values, 
call energy is the relative value. As a rule, in call spectrum, the energy 
is distributed over a few frequency bands. The largest peak in the ana-
lysed time window is considered as zero, and the others are calculated 
relative to it to the negative side.

Call energy is commonly measured in decibels. Decibel means deci-
mal logarithm of unsized ratio of two sound intensities. This is not an 
absolute value, as, e.g., seconds, Hertz or meters, but the relative value, 
as e.g., integer multiples («three-fold difference»), percent or propor-

Figure 1. Three basic forms of sound visualizing — oscillogram (a), power 
spectrum (b) and spectrogram (c). T — oscillation period of sound wave.
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tion, designed for measuring the ratios of two values of intensity, and 
to the obtained ratio, the logarithmic scale is applied. For subjective 
perception, increase of intensity for 10 dB approximately corresponds 
to increase the sound loudness twice.

Thus, there are three ways to visualize the sound wave: oscillogram, 
spectrogram and power spectrum (Fig. 1), which allow measuring three 
groups of sound parameters: time (in seconds), frequency (in Hz) and 
power (in decibels). Still recently, sound visualization demanded ap-
plying special devices. Now, progress of electronics and computer tech-
nique allows conducting the spectral analysis easily, fast and inexpen-
sively. High-speed processor and sound card is all what is necessary for 
transforming a personal computer to powerful spectrograph.

Signals coming from microphone have analogous representation. For 
creating spectrograms on a computer, these signals should be digitized, 
that is, to receive the digital representation. This can be made using 
a special converter, which is a part of sound card or any digital audio 
recorder.

Analogous signals are continual by frequency and amplitude. This 
means that, at any time moment, sound amplitude can be measured 
with unlimited precision, in contrast to the digital signal representa-
tion, consisting of a number of separate measurements, which can on-
ly be setup using a limited number of different discrete values (11025, 
22050, 44000, 48000 etc.). The number of sound wave measurements 
per second is termed sampling rate and measured in kHz. If sampling 
rate is high enough, the original analogous signal can be created again 
without any sufficient mistakes. Sampling rate should exceed the max-
imal fundamental frequency of the analogous sound signal at least 

Figure 2. Analogous (a) and digital (b) ways of sound representation.
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twice. The Fig. 2 illustrates the differences between the analogous (a) 
and digital (b) ways of sound representation.

Parameters for creating spectrogram

Spectrogram and information which can be extracted on its basis, are 
predetermined by parameters used for creating the spectrogram. These 
parameters determine resolution of call acoustic structure in time and 
frequency domains. Choice of parameters for creating spectrograms is 
always a trade-off, because, if you need the high resolution of frequen-
cy scale, you cannot receive respectively high resolution on time scale 
(keep in mind that f=1/Т). So, you should decide in advance, whether 
you need the high resolution in frequency or high resolution in time, ac-
cordingly to the particular bioacoustical task which should be resolved.

When describing parameters for creating spectrogram, we will il-
lustrate them by examples using the interface of the professional bio-
acoustical software Avisoft-SASLab Pro (www.avisoft.com). However, 
selection of parameters for creating spectrograms can be done similarly 
using any other professional software for sound analysis. Avisoft has the 
following options for creating spectrograms.

Sampling frequency
Sampling frequency sets the upper limit of call spectrum and thus de-

termines the maximum frequency visible on spectrogram. Sampling fre-
quency restricts the maximum frequency of the digitized signal to the 
half of its value. The higher is sampling frequency, the higher-quality 
digitizing will be achieved. Based on Kotelnikov theorem, sampling fre-
quency for precise re-storing the original signal should exceed two times 
the maximum frequency of interest of the signal. Transformation of the 
analogous signal to the digital signal includes two stages: time discreti-
zation and amplitude quantization. Time discretization means that the 
signal is represented as a set of scores (samples), taken at equal time in-
tervals. For example, when we say that sampling frequency is 44.1 kHz, 
this means that the signal was measured 44100 times per second.

FFT-length
The FFT (Fast Fourier Transform) length, together with frame size 

and window type, determines spectrogram frequency resolution. The 
FFT value reflects at which values two close-frequency components of 
the signal still can be separated. Larger FFT values smooth the struc-
tures of transitional signals, so that a few close-time tonal impulses can-
not be separated. In other words, time resolution will be poor.
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Frame size
The influence of frame size on the spectrogram image can be com-

pared with the influence of FFT length. A smaller frame size results in 
the lower frequency resolution and the higher time resolution. Theo-
retically, FFT spectrum length of 512 points, combined with frame size 
50 % would result in the same spectral resolution as the spectrum with 
256 points and frame size 100 %. The only difference would be that, 
at larger FFT length, spectrogram will have a higher resolution for the 
account of the larger number of spectral lines.

Window type
The FFT algorithm provides precise spectra only if time section of 

audio recording overlaps the total number of periods in the periodic 
signal. This is a very special case, not reported in practical guidelines. 
If this demand was not met, the resulting spectrum will be thumb with 
false high frequencies (spectrum spread). For diminishing this effect, 
smoothing windows can be used, which decrease the amplitude near 
the edge of the recording section. There are different types of windows, 
influencing differently spectrum spread and frequency resolution. The 
Hamming Window has the best characteristics for most cases: good sup-
pression of spectral spread and good frequency resolution. The FlatTop 
Window is distinctive by a larger frequency range with relatively flat-
tened transmission characteristics. The FlatTop Window provides a high 

Figure 3. Influence of window type on the spectrogram image: a — FlatTop 
window and b — Rectangle window.
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time resolution for the account of frequency resolution. This window 
allows creating spectrograms, similar with broadband spectrograms 
generated by dynamic spectrographs with wide filter. Please compare 
two figures: the first spectrogram was created with FlatTop Window, 
the second one was created with Rectangle Window (Fig. 3).

Overlap
Spectrogram image represents an ordered picture of single spectra. 

For each spectrum, a restricted part (time section) of the entire time 
signal is taken. Sequential time sections can be organised in overlap-
ping mode, what means that the same part of time signal is used for a 
few sequential spectra. Such overlap provides a higher time resolution, 
as the number of spectra per second is increased. The value of overlap 
should be adapted to the type of window and frame size. Small frame 
sizes need a high overlap, because otherwise some parts of time signal 
will not be present in some spectra of the particular spectrogram. Please 
compare two spectrograms on the Figure 4: both of them are created 
with maximal window size, but the first one is created with overlap 
50 %, and the second one with overlap 100 %.

Figure 4. Influence of Overlap on the spectrogram image: a — overlap 50 % and  
b — overlap 100 % at the same Hamming type of window.
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Task 1.
Manual measurements of essential 

time-frequency parameters with Avisoft-
SASLab Pro. Statistical analysis of 

acoustic variability of the calls

Study objects

Chicks of red-crowned crane, Grus japonensis (monogamous territori-
al species) and ancient murrelet, Synthliboramphus antiquus (monoga-
mous colonial species) will be used as objects of this task.

Aims of the work

1) to measure time, frequency and power parameters of suggested 
calls of 8 individual chicks of the two bird species using the reticule cur-
sor and the standard marker cursor for estimating variability of chick 
calls of each species;

2) to conduct a statistical analysis of the measured parameters for es-
timating the individual and sex-based variation of the calls.

Introduction. Why these two bird species were 
selected for comparison?

Red-crowned crane, as other Gruidae species, is strictly monoga-
mous: a parental pair raises one or rarely two chicks per breeding 
season. For the first three months of chick life, parents stay on their 
family territory together with their offspring and defend the terri-
tory from other cranes. Members of own family cannot be therefore 
confused with alien cranes. The calls suggested for analysis were re-
corded from chicks of about one month of age, that is, during the 
season when crane family is strictly territorial. So, we can predict 
that individual differences of chick calls might not be well-expressed 
at this age. Red-crowned crane chicks produce calls of four structural 
classes: trills, whistles of two types, differing in the contour of fre-
quency modulation, and intermediate calls between trills and chirps 
(Fig. 5).
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The suggested for analysis chirps C2 were emitted by the red-crowned 
crane chicks in various contexts, for instance during food begging, pre-
flight activity or in other contexts including active movements. Chirps 
C2 are most widespread calls of red-crowned crane chicks, compris-
ing 45–90 % of all sound signals depending on the ontogenetic stage. 
During the first 8–12 months of chick life, time and frequency param-
eters of chirps C2 are kept practically unchanged in spite of the over 
40-times body mass gain (these chirps retain their high juvenile fun-
damental frequency exceeding about three times the adult fundamen-
tal frequency). At 8.5–11 months of age, both sexes experience voice 
breaking with rapid (within a few weeks) changes of the high-frequen-
cy chick-like calls to the low-frequency adult-like calls.

Ancient murrelet is a colonial seabird from Alcidae family. In contrast 
to many other seabirds, ancient murrelets use colonies only for incu-
bation. The hatched chicks depart their nest burrows in the second 

Figure 5. Spectrograms of four structural call classes of red-crowned crane chicks: 
trills (a), chirps C1 (b) and C2 (c), and intermediate calls between trills and chirps (d).

Figure 6. Spectrograms of the individualistic chirps of four different ancient 
murrelet chicks, two chirps per chick.
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night and then are fed by their parents in the see. Mass synchronous 
departure of thousands of chicks from a colony occurs at nights, to 
avoid predation from numerous diurnal raptors. Ancient murrelets 
have poor nocturnal vision, so, the acoustical channel is a single com-
municative channel between chicks and parents. Both parents and 
chicks have individually distinctive “signature calls”, differing by their 
unique frequency modulation, which enable unmistakable recognizing 
each other among thousands of conspecifics. Chicks of ancient mur-
relet, commonly emit their individualistic chirps in series of 2–8 calls, 
what probably allows to increase reliability of individual recognition. 
The suggested for analysis calls were recorded in a natural colony of 
ancient murrelets in the Talan Island (Okhotsk see) during the mass 
chick departure (Fig. 6).

Important!!! As example for illustrating acoustic variation, in this 
task, we will only talk about individual and sexual variation of calls. Oth-
er modalities of acoustic variation (age-related, context-related, popula-
tion-specific etc.) can be studied with a similar way.

Task for the practical work.  
Part 1. Acoustics

The calls suggested for analysis were recorded at a distance 2–15 m to 
microphone from 8 individual 40–65-day-old red-crowned crane chicks 
and from 8 individual 2-day-old ancient murrelet chicks. Audio files 
of these calls are available at link http://bioacoustica.org/practicum/
practicum_eng.html, the file names correspond to individual chicks; 
each file contains calls of only one individual chick (for the red-crowned 
crane, chicks 1–4 are females, 5–8 — are males; the ancient murrelet 
chicks are unsexed). The inter-call intervals were artificially shortened 
for analysis convenience; some recordings of ancient murrelet chicks 
contain also calls of conspecific adults.

For creating call samples, you should measure 10 calls per chick, 
80 calls per species. Please select calls randomly from different parts 
of recordings avoiding to take calls following each other. For ancient 
murrelet chicks, preferably take one call per series selecting one of the 
last calls of a series, as the calls at the end of the series are commonly 
more intense and thus higher-quality. The random choice of calls for 
analysis decreases the potential effect of pseudoreplication because of 
the influence of the acoustic structure of a preceding call to the fol-
lowing call.

http://bioacoustica.org/practicum/practicum_eng.html
http://bioacoustica.org/practicum/practicum_eng.html
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Step-by-step guide to the work  
with Avisoft-SASLab Pro

This section describes the measuring of the essential acoustic param-
eters and their export to external softs with a professional bioacoustical 
software Avisoft-SASLab Pro (www.avisoft.com). Below, you will find 
the instructions for selecting the settings for creating spectrograms of 
desirable image, for selecting call parameters for measuring, and for 
preparing the tables for saving the exported measurements.

1. Open Avisoft, then open one of suggested files, for example, file «g1». 
You will see 46 calls of one individual red-crowned crane chick. The calls 
are shown in two windows: as waveform (oscillogram) (Fig. 7a) and as 
spectrogram (Fig. 7b). Above, there are working buttons of Avisoft. The 
first three buttons enable audio recording (Fig. 7 (1)), playback of the 
existing recording (Fig. 7 (2)) and interruption of recording or playback 
(Fig. 7 (3)). In the current task, files for analysis are already prepared, 
so it is unnecessary to make an audio recording. You can listen the calls 
from this file by pressing the button «Playback of marked section» (Fig. 7 
(2)). By placing the mouse to each button, you can read its function in 
the box below the spectrogram window. Using the mouse cursor, you can 
label some file fragment and then, with double press of the left key of the 
mouse on this fragment, to zoom it to all screen. For the same purposes, 
you can also use the 5 working buttons of the software (Fig. 7 (4)).

Figure 7. Main window of Avisoft-SASLab Pro: a — waveform (oscillogram),  
b — spectrogram. The mentioned in the description working buttons are marked 
with numbers.
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2. Using the «Overview Display Parameters» button (Fig. 7 (5)), you 
can change the spectrogram settings in the main window for more con-
venient visual inspection of audio recording. Try to change each param-
eter of the settings separately and then observe, how this change modi-
fies the spectrogram image.

3. Press the button «Sound card settings» (Fig. 7 (6)). You will see, that 
Sampling frequency of the given file is 22050 Hz. This means that spec-
trogram allows analysing frequencies up to 11025 Hz. However, aver-
age call frequencies of red-crowned crane chicks are substantially lower, 
about 3000 Hz. So, for increasing the spectrogram frequency resolution, 
it is convenient to downsample the sampling frequency from 22050 Hz 
to 11025 Hz using the button «Sampling frequency conversion» (Fig. 7 
(7)). Respectively downsample for analysis the calls of the ancient mur-
relet chicks from 48000 Hz to 22050 Hz (because in this species, chick 
calls are higher-frequency than in the red-crowned crane chicks).

Important!!! Do not forget to change sampling frequency each time af-
ter a file opening. Calls of all individual chicks should be measured at the 
same frequency resolution.

4. The opened main window of Avisoft (displaying waveform and 
spectrogram) is convenient for conducting the visual inspection of large 
call massive. However, conducting measurements is impossible in this 
window (for the exclusion of the overall call duration). For measuring 
other call parameters, you would need to use the spectrogram window. 
Press the button «Create spectrogram» to open the spectrogram win-
dow (Fig. 7 (8)). If you want to create spectrogram of the entire audio 
file, delete preliminary the labelling the file to fragments; otherwise, 
the spectrogram will only be created for the labelled fragment. By-de-
fault parameters for creating spectrogram can be inappropriate for the 
analysed calls. As a rule, for each particular case, the settings for creat-
ing spectrogram should be selected manually. To select parameters for 
creating spectrogram, close the already created spectrogram and press 
the button «Spectrogram parameters» (Fig. 7 (9)). Try to change the 
settings of the three parameters (FFT-length, Frame, Overlap) and then 
observe how this will change the spectrogram image. Select those spec-
trogram parameters, which, on your opinion, are most appropriate for 
analysis of the given call type. Two most convenient sets of parameters 
for analysis of red-crowned crane chick calls are shown on figure 8.

Important!!! Write-down the parameters which you selected for creat-
ing the spectrogram, as well as the values of time and frequency resolu-
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tions which these parameters allow to reach. This will allow to reproduce 
the measurements at any time with the same resolution and precision.

5. Open the spectrogram window to start measuring call parameters 
(Fig. 9). You can change the brightness and contrast of spectrogram by 
using the button «Display parameters» (Fig. 9 (1)). You can also obtain 
additional information about the spectrogram, by using the button «Ad-
ditional Spectrogram Information» (Fig. 9 (2)). Please train yourself, 

Figure 8. Example sets of parameters for creating spectrograms enabling the 
accurate measurements of red-crowned crane chick calls.

Figure 9. Spectrogram window in Avisoft-SASLab Pro. Working buttons 
mentioned in the description are marked with numbers.
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by changing each setting and observing how each change modifies the 
spectrogram image. Finally, select the combination of settings shown on 
figure 10. Checkmarking the «Maximum» checkbox of «Spectrogram» 
option (Fig. 10) will display a red line showing the positions of call 
frequency maxima at each time moment (Fig. 11). This option allows 
using the reticule cursor during manual measurements in cases when 
frequency contour is not enough clear, to make more precise measure-
ments of frequency modulation on spectrogram.

Figure 10. A possible set of additional parameters which can be used for creating 
spectrograms for accurate measuring of the acoustic parameters of red-crowned 
crane chick calls.

Figure 11. Spectrogram window in Avisoft-SASLab Pro, ready for analysis. Red line 
on the screen indicates the points of call maximal intensity at each moment of time.
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6. Go to spectrogram window menu (Display → Lower Cut-Of Fre-
quency). This option provides filters for cutting off the irrelevant to cur-
rent analysis call frequencies, such as background noise higher or lower 
the frequency spectrum of interest. As chick calls of both species are 
higher than 1 kHz, the frequencies below 1 kHz are irrelevant to anal-
ysis, so you can apply the high-pass filtering to cut off the frequencies 
below 1 kHz.

Please also pay attention to another checkbox from the menu of the 
spectrogram window: Display → Absolute Time Scaling. If this check-
box is marked, time scale of the spectrogram window corresponds to 
the time scale of the main window of Avisoft. That is, if you created 
the spectrogram of a selected fragment within file (not spectrogram of 
the entire file), the time scale of the spectrogram window will not start 
from zero. If this checkbox is unmarked, time in the spectrogram win-
dow will start from zero. It is better to put this checkmark, and then you 
will easily determine from the transferred to Excel time scores, which 
calls were measured in each file.

7. Now you made the settings for the spectrogram window and all 
is ready for call measuring. Spectrograms of chick calls are created at 
good resolution in time and frequency, the alien noises are filtered out, 
all necessary information is put on the screen (Fig. 11). Your next step 
is to select the parameters for acoustic analysis. In this practical task, 
you will make the manual measurements of acoustic parameters using 
the «Free moveable reticule cursor» (Fig. 9 (3)). At clicking this cursor 
at any point of spectrogram image, three scores will be copied to the 
exchange buffer at the point of crossing the cursor lines: coordinates of 
time and frequency as well as call energy. By clicking the cursor on the 
beginning and then on the end of a call, you can calculate additional 
parameters, for example, the total call duration, the fundamental fre-
quencies at the beginning and at the end of a call. Now, we should select 
the particular call points, whose coordinates we will measure in each 
call during this practical task.

Important!!! For measuring the calls of the red-crowned crane chicks, 
you should select the following 4 points for measuring with the reticule 
cursor: the point of call beginning, the point of call fundamental frequen-
cy maximum, the point of the first extremum (the first inflection) of fre-
quency contour after the call fundamental frequency maximum, and the 
point of call end (Fig. 9 (4)). For the ancient murrelet chicks, you should 
select the following 4 points for measuring for obtaining the comparable 
data with crane chicks: the point of call beginning, the point of call fun-
damental frequency maximum, the point of the following this maximum 
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first extremum (first inflection after the maximum) and the point of call 
end. Selection of the same parameters sets (numbers and modalities) jus-
tifies conducting a comparison of the degree of acoustic variation between 
species.

8. You can also make another measurement for each study species: 
calculation of the dominant frequency of the entire call (the frequency 
of call maximum intensity). For doing this, please mark the entire call 
(Fig. 9 (5)) with the Standard marker cursor (Fig. 9 (6)), and then click 
twice with a mouse on the call power spectrum (Fig. 9 (7)). Another 
Avisoft window the Power spectrum window will be opened, where X 
axis indicates call frequency and Y axis indicates call amplitude (sound 
energy) at the given time moment (Fig. 12).

In the power spectrum window menu, put the checkmark in the 
checkbox Display → Special Characteristics. In the appeared window 
(Fig. 12), you can select parameters which Avisoft will measure from the 
labeled by you time section (it can be either the entire call or call frag-
ment): dominant frequency («Maximum at Freq.»), quartiles («Quar-
tiles»), the wide of the frequency peak («Bandwidth») and its lower 
and upper borders («min Frequency» and «max Frequency») at the ar-
bitrary given distance from the frequency maximum («Threshold»). In 
this practical task, we will only need one power spectrum parameter, 
the dominant frequency. To solely copy the dominant frequency to the 
exchange buffer, please put the checkmark only in the checkbox «Peak 

Figure 12. Power spectrum window in the Avisoft-SASLab Pro. The window for 
measuring power parameters is shown on the left.
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at Frequency» (Fig. 12). Press «Copy» for copying the measured value 
of the selected parameters to the exchange buffer. If you will fill out the 
window «Special Characteristics» as it is shown on figure 12 and then 
press the button «Copy», only one value will be copied to the exchange 
buffer (2320 Hz in this particular case).

9. The next step is to prepare an Excel file to which Avisoft-SASLab Pro 
will automatically copy your measurements. Please open a new Excel ta-
ble and save it (file name should be in not more than 7 Latin letters). For 
convenient analysis of the obtained measurements, please prepare the 
table with the following way: all measurements taken from a call should 
be in one line of table, all measurements from the next call should be in 
the next line of table etc. The Fig. 13 displays an example table, which 
format is convenient for the purposes of the given practical task.

First three columns of this table should be filled manually. The first 
column contains chick individual numbers (IDs ##1–8), the second 
column contains chick sex (males are indicated with digit 1, females 
with digit 2, so, female red-crowned crane chicks IDs ##1–4 should 
be marked with digit 2, whereas male red-crowned crane chicks IDs 
##5–8 should be marked with digit 1). The third column contains the 
sequential number of a call from each chick (you should measure at 
minimum 10 calls per chick). Next 13 columns of the table will be au-
tomatically filled by Avisoft-SASLab Pro. First 12 of them will contain 
the values copied to the exchange buffer when you press the reticule 
cursor on each of the described above call points (indicating fundamen-
tal frequencies at the beginning, maximum, inflection point and end 
of the call). A click of the reticule cursor on any point of spectrogram 
will always copy to the exchange buffer the all three measurements in 
one time. The measurements will be always recorded in the same order: 
first the coordinates on the Х axis (time axis); second the coordinates 

Figure 13. Example of table ready for the automatic data export from Avisoft-
SASLab Pro.
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the У axis (frequency axis); and third the coordinates on the power axis 
(reflected on spectrogram by gradations of grey color). Finally, in the 
last (13th) column, the measurements of the dominant frequency of the 
entire call will be written (the parameter which you measured separate-
ly in the power spectrum window).

Important!!! Be careful: you can only conduct the measurements in the 
strict order (for example, you can at first conduct the measurement with 
the reticule cursor and then measure the dominant frequency; the illustra-
tive table on Fig. 13 just indicates this order). The selected order of mea-
surements cannot be changed during the work; all call parameters should 
be measured in the same order! Otherwise, your table with measurements 
will turn to be a senseless set of digits.

10. Finally, you should connect the Avisoft and Excel and indicate, to 
which Excel file and to which lines of the Excel table the Avisoft should 
copy your measurements. To make this, go back to the spectrogram 
window and select from menu: File → Data export → DDE-Parameters/
Log-File. If your Excel table is looking in the same way as the table on 
Fig. 13, the appeared window should be filled with the following way 
(Fig. 14):

1) fill the field Topic (name and extension of your Excel file);
2) fill the field Item — as it is necessary to indicate the coordinates of 

the cell of your table, to which Avisoft should copy the first measure-

Figure 14. Avisoft-SASLab Pro window enabling external export of 
measurements. The way how this window has to be filled corresponds to the 
learning purposes of practical Task 1.
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ment (R — line, C — column); the further measurements Avisoft will 
copy to the same line, one after another;

3) indicate after how many clicks (= measurements), Avisoft should 
hop to another line (that is, how many measurements of each call you 
are going to do); in our example table it is after five measurements (of 
the five measurements, four we conduct with the reticule cursor and 
one in the power spectrum window).

11. Now, after making all necessary settings, you can start the mea-
surements. Measurements of calls would be better to make in a separate 
table for each species or on separate pages of one table.

Task for the practical work.  
Part 2. Statistics

After measuring a sufficient number of calls per chick, come to the 
next part of work, to evaluate the degree of individual and sexual vari-
ation in the two study species. Let’s consider a few most widespread 
statistical methods for estimating acoustic variation (including the indi-
vidual variation of animal calls).

One simple method is calculating coefficients of variation (CV), mea-
sured in percent by formula CV = (SD/Mean)*100 %, where SD is stan-
dard deviation and Mean is the average value of the measured parame-
ter values. You can also calculate the ratio of CV between individuals to 
CV within individual, to estimate how strongly interindividual variation 
exceeds the intraindividual variation. However, coefficient of variation 
only enables comparing the intra- and interindividual variation for each 
call parameter and for each individual separately, but CV does not allow 
to evaluate individual variability on the basis of the entire set of the 
measured parameters.

More precise statistical methods for estimating acoustic variation 
are ANOVA, MANOVA, DFA (Discriminant Function Analysis), clus-
ter analyses, classification tree methods etc. ANOVA and MANOVA 
enable estimating the effects of one or a few factors (in our example, 
the factors are chick individual identity and sex) on dispersion of the 
normally distributed random value, observed at different factor values 
(in our example study, the random value is represented by the values 
of one of the measured call parameters). ANOVA and MANOVA enable 
to compare variation of each of the measured parameters for calls of 
each individual animal with variation of the random value in calls of all 
individuals. ANOVA and MANOVA calculate Fisher’s criterion (F-ratio) 
for each of the measured call parameters and allow to estimate, which 
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call parameters are most individual-specific (that is, possess by weak in-
tra-individual and high inter-individual variability). However, ANOVA 
or MANOVA-based methods have the same problem as CV-based meth-
od, as they deal with each parameter separately and cannot consider a 
few call parameters in combination.

As the number of call parameters measured during a study is often 
large, so, for estimating the individual differences would be conve-
nient to use the methods of multiparametric statistics, which estimate 
the effect of the whole set of parameters. Cluster analysis is one such 
method. Cluster analysis is designed to search a similarity between 
the analysed objects (calls in the given case). Objects are considered 
the more similar, the less are the differences between the matched pa-
rameters (measured call parameters in this case). For determining the 
spatial closeness of a pair of points in multidimensional space, most 
used option is the Euclidе distance, which is equal to square root of the 
sum of squares of differences in values of matched parameters, taken 
for the given pair of objects. Among deficiencies of cluster analysis is a 
substantial limitation on the number of analysed objects (on the num-
ber of calls in this case).

One of the most common and powerful statistical methods used for 
estimating the individual and sexual variations is discriminant analysis. 
For applying this analysis, a researcher should select the analysed ob-
jects (all massive of calls in this case), parameters, characterizing these 
objects (all acoustic parameters in this case), and number of groups, 
to which it is necessary to subdivide the analysed object (number of 
individuals in this case). The aim of discriminant analysis is to calculate 
(n–1) of linear functions, which maximize the probability of correct as-
signing the objects to n groups (to maximize the probability of correct 
assigning the analysed calls from each individual to a particular group, 
in this case). Due to the general estimating all parameters of analysed 
objects, discriminant analysis currently is mostly used statistical meth-
od, applied in studies of vocal individuality. However, the results of dis-
criminant analysis (percentage of correctly assigned calls) strongly de-
pend on the number of groups (individuals), calls, included in analysis, 
and selected by researcher parameters, included in analysis, so, they 
should be estimated (by using an especial randomization procedure) 
for the degree of significance. Limitations of discriminant analysis and 
the ways of their estimation and testing the results will be considered 
below, in the practical Task 2.
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Step-by-step guide to the work with  
STATISTICA and The R software

In this section, we describe the way of preparing data tables, based on 
the results of a preceding task, on measuring of time-frequency param-
eters in calls of chicks of two species, for further statistical analysis with 
STATISTICA (http://statsoft.ru/) or The R (https://www.r-project.org/). 
Instructions for conducting discriminant analysis with each of these 
software and calculating the average percent of correct assignment of 
calls to individuals (for red-crowned crane chicks to both individual and 
sex) are given below.

STATISTICA
1. Prepare your Excel table with measurements for the statistical anal-

ysis. Let’s start with the values of time parameters (as the reticule cursor 
copies to the exchange buffer only coordinates of respective points, the 
durations of different call parts might be calculated on the basis of the 
obtained measurements manually). Using simple formulas available in 
Excel, you can calculate, for example, Dur_beg-max (duration from the 
beginning of a call to the point of call maximum fundamental frequen-
cy) = T_max-T_beg; Dur_beg-ext (duration from the beginning of a call 
to the inflection point of call contour) = T_ext-T_beg; Dur_beg-end 
(entire call duration) = T_end-T_beg.

After calculating these time parameters, you can delete the already 
unnecessary columns with time and power coordinates (before deleting 
them, please obligatory save the Excel table under a new name, in order 
to return to the initial file in case of mistake, and change the introduced 
formulas to the values). Example of table prepared for the statistical 
analysis is present on Figure 15.

Figure 15. Example of table prepared for statistical analysis with STATISTICA.

http://statsoft.ru/
https://www.r-project.org/
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2. Open the prepared table with STATISTICA software. To do this, 
please checkmark File → Open in the main menu; checkmark «All 
Files» in checkbox «File type» and open the table. In the pop-up win-
dow, checkmark «Import selected sheet to a Spreadsheet» and label the 
page where there are data for the statistical analysis. In the next opened 
window, put a checkmark in the «Get variable names from first row» 
checkbox and press «Ok». Your table will be opened in the main window 
of STATISTICA.

3. To run the discriminant analysis procedure for analysis of individ-
ual-based acoustic variation, please select from the main menu Statis-
tics → Multivariate Exploratory Techniques → Discriminant Analysis. 
A window will appear, in which you will need to indicate to how many 
groups STATISTICA should subdivide the analysed objects (calls) and 
also indicate the variables (call parameters), which will serve for classi-
fying the calls to the predicted number of groups (Fig. 16).

Press the button «Variables». Select a column encoding individual 
identity of the calls in the box «Grouping variable». Select a set of col-
umns with measured parameters in the field «Independent variable list» 
(Fig. 17). Press «Ok».

Press the button «Codes for grouping variables», select «All» and press 
«Ok». The button «Select Cases» in the right part of window (Fig. 16) 
can be used for selecting the groups to which you are going to apply 
the discriminant analysis procedure. For example, if you would like to 
include in analysis only the calls of males or females, you can, with ap-
propriate choice of these settings, calculate the values of correct assign-
ment of the calls to each sex separately.

Figure 16. Window in STATISTICA providing options for selecting the grouping 
variable and call parameters for conducting discriminant analysis.
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Checkmark the «Advanced options» checkbox (Fig. 16), press «Ok». 
In the checkbox «Method» select «Forward stepwise». Press «Ok» again. 
You have run the discriminant analysis procedure.

4. Let’s consider the obtained results of the discriminant analysis. If 
you have run discriminant analysis successfully, you will see the window 
with its results. The simplest way of presenting the results is calculating 
percentages of correct assignment of calls to particular individuals. Se-
lect the box «Classification», and then press the button «Classification 
Matrix». STATISTICA will show you the table with the results (Fig. 18).

Figure 17. Window in STATISTICA displaying how to select the grouping variable and 
measured parameters for conducting discriminant analysis suggested in this task.

Figure 18. Window in STATISTICA displaying classification matrix of discriminant 
analysis, obtained for 80 calls of 8 individual red-crowned crane chicks calculated 
on the basis of the 8 time-frequency parameters of the calls.
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For instance, in the example given on Fig. 18, the average percent 
of correct assignment of calls to individual is 97.5 %. Among individu-
als, the percent varies from 80 (in Chick #5) to 100 % (in all remaining 
chicks). You can see that 2 calls of Chick #5 were classified inaccurately 
(being assigned to a group of calls of Chick #4).

Additionally to calculating percentage of correct assignment, dis-
criminant analysis shows the contribution of each parameter to accu-
rate classification (that is, it shows which parameters are more individ-
ual-specific and which are less). In order to see this, please return to 
the start window with results of discriminant analysis (by pressing the 
button «Discriminant Function…» in the bottom of the main window 
of STATISTICA), select the box «Advanced» and then press the button 
«Summary: variables in the model».

You will see the list of parameters, included to analysis by STATIS-
TICA. In the case presented on Figure 19, the entire set of all variables 
was included in analysis, although, in principle, the software can dis-
card some parameters non-contributing to classification (in order to see 
the list of parameters discarded from analysis, please select the button 
«Summary: variables not in the model»).

Stepwise discriminant analysis put parameters in the order of their 
decreasing importance for classifying success. In the case illustrated on 
Figure 19, the parameter mostly introducing in discrimination of calls 
of different individuals is the end fundamental frequency (F_end), 
whereas parameter least introducing in discrimination was dominant 
frequency (F_peak).

Figure 19. Window in STATISTICA displaying parameters included in discriminant 
analysis and percentages of their contribution to classification.
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You also can create the graph of distribution of the analysed objects in 
two-dimensional space (Fig. 20). For doing this, select box «Advanced», 
then button «Perform canonical analysis», then «Scatterplot of canoni-
cal scores» and select any two axes of the multidimensional space; press 
«Ok». Unfortunately, in STATISTICA 8.0, objects from different groups 
are only color-labeled if the number of groups (here the chicks) does 
not exceed 6; in other cases, the objects of different groups do not differ 
by color and form. Axes («Roots») which discriminant analysis calcu-
lates, are functions of a few correlated parameters, so their number is 
not equal to the number of parameters included in analysis.

You can look which calls were classified incorrectly. Press the box 
«Classification», then the button «Classification of cases». In the ap-
peared table, you will see the results of classification for each call; the 
incorrectly classified calls are marked with asterisk.

5. For sexual (or any other) variation, discriminant analysis can be 
done in a similar way. Please return to the start of discriminant analysis 
and select «Sex» in the «Grouping variable» box instead of «Chick N» (in 
the current task, this possibility is only available for red-crowned crane 
chicks). Then repeat all the described above procedures and try answer-
ing the questions: What differences (individual or sexual) are expressed 
clearer in the chicks? What can be reasoning for this?

Figure 20. Window in STATISTICA displaying the graph of distribution of the 
analysed objects in two-dimensional space using two first functions, calculated 
on the basis of discriminant analysis. In this case, only first 6 chicks were included 
in analysis.
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The R
1. For conducting discriminant analysis in The R software, modify 

slightly the initial data table prepared for analysis with STATISTICA 
(Fig. 15). First, avoid the intervals between words in names of the col-
umns (for example, the name of column 1 from our example «Chick N», 
should be replaced with «Chick_N»); second, for simplifying the proce-
dure, delete all extra columns from the table, keeping only those which 
will be included in analysis (for example, you should delete the column 
«Sound N» and column «Sex» or «Chick_N» depending on what analysis 
you are conducting in the given moment (for individual or for sexual 
variation of the calls; Fig. 15). Then, Excel file should be saved in txt 
format with separating tabulation.

2. Upload the obtained table to The R. To do this, enter the following 
code to the working field of R:

library(MASS)
setwd(«C:/My documents/R/»)
crane <- read.table(file = «primer.txt», dec = «,», header = TRUE)

where the field «C:/My documents/R/» indicates the place where 
your table is saved; «primer.txt» is the name of your table. The field 
«crane» is the name of database of the prepared for analysis table; you 
can select any different coding name for subsequent actions with the 
uploaded database. For this task, example coding can be downloaded at 
link http://bioacoustica.org/practicum/practicum_eng.html.

3. Please check whether your database was uploaded successfully. To 
do this, use the following commands in the working space of R:

str(crane)
names (crane)

If the database was uploaded correctly, The R will show the list of 
values of the variables and the list of names of the variables which it 
sees in the database:

> str(crane)
‘data.frame’:   80 obs. of  9 variables:
 $ Chick_N    : int  1 1 1 1 1 1 1 1 1 1 ...
 $ F_beg      : num  2.33 2.26 2.31 2.24 2.21 ...
 $ F_max      : num  2.85 2.97 2.96 2.76 3.21 ...
 $ F_ext      : num  2.41 2.37 2.38 2.27 2.59 ...
 $ F_end      : num  2.23 2.23 2.26 2.18 2.23 ...
 $ F_peak     : int  2390 2370 2370 2270 2580 2340 2320 2300 2570 

2400 ...
 $ Dur_beg-max: num  0.066 0.074 0.067 0.052 0.087 0.103 0.1 0.11 

0.082 0.11 ...

http://bioacoustica.org/practicum/practicum_eng.html
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 $ Dur_beg-ext: num  0.079 0.091 0.086 0.081 0.115 0.129 0.13 0.128 
0.101 0.142 ...

 $ Dur_beg-end: num  0.292 0.286 0.283 0.277 0.324 0.297 0.281 
0.274 0.335 0.355 ...

> names (crane)
[1] «Chick_N»     «F_beg»       «F_max»       «F_ext»       «F_end»      
[6] «F_peak»      «Dur_beg-max» «Dur_beg-ext» «Dur_beg-end»

In our example the R reports us that it uploaded the database, in 
which 80 observations are present, differing by 8 parameters.

4. To start discriminant analysis, use the following commands in the 
working space of the R:

M3 <- lda(crane$Chick_N~.,crane)
misclass <- function(pred, obs) {
tbl <- table(pred, obs)
sum <- colSums(tbl)
dia <- diag(tbl)
msc <- dia/sum * 100
m.m <- mean(msc)
cat(«Classification table:», «\n»)
print(tbl)
cat(«percent of correct classification:», «\n»)
print(round(msc, 1))
cat(«Mean percent of correct classification:», round(m.m, 1), «\n»)
}
misclass(predict(M3)$class, crane$Chick_N)

where «crane» is the given by you name for the uploaded to the R 
database and a «Chick_N» is the grouping variable for conducting dis-
criminant analysis.

The R will show you the following results:
Classification table: 
    obs
pred  1  2  3  4  5  6  7  8
   1 10  0  0  0  0  0  0  0
   2  0 10  0  0  0  0  0  0
   3  0  0 10  0  0  0  0  0
   4  0  0  0 10  2  0  0  0
   5  0  0  0  0  8  0  0  0
   6  0  0  0  0  0 10  0  0
   7  0  0  0  0  0  0 10  0
   8  0  0  0  0  0  0  0 10
percent of correct classification: 
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  1   2   3   4   5   6   7   8 
100 100 100 100 80 100 100 100 
Mean percent of correct classification: 97.5

We obtained the classification matrix, where the average percent of 
correct assignment of calls to individual is 97.5 %, that is, the same per-
cent as was obtained with STATISTICA. Among individual chicks, per-
cent of correct assignment of calls to individual varies from 80 (Chick 
#5) to 100 % (all other chicks). Two calls of Chick #5 were incorrectly 
classified (and were assigned to a group of calls of Chick #4).

5. In the same way, you can conduct discriminant analysis for sexual 
(or any other) variation. Please return to the initial database table and 
use the column «Sex» instead of the column «Chick_N» (in this task, this 
possibility is only available for red-crowned crane chicks). Then repeat 
all the above-described procedures and compare the obtained results 
with those from STATISTICA.
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Task 2.
Visual inspection of acoustic variation, 

definition of «signature» calls. 
Comparison of results of quantitative 

(measuring) and qualitative  
(visual) analyses

Study objects

Again, in the practical Task 2, our objects are the chicks of the red-
crowned crane Grus japonensis (monogamous territorial species) and 
of the ancient murrelet Synthliboramphus antiquus (monogamous co-
lonial species).

Aims of the work

1) to visually compare call contours of 8 individual chicks per species 
for estimating the acoustic variation of chick calls of each species;

2) to compare the two ways of calls classifying, the quantitative (con-
ducting using discriminant analysis in the practical Task 1) and quali-
tative (conducted in the current practical Task 2), applied to the same 
samples of calls and matched samples of individuals;

3) to evaluate, by using randomization procedure, the results of dis-
criminant analysis of acoustic variation in call parameters obtained in 
the practical Task 1.

Introduction. Methods for estimating the degree 
of acoustic variation of the calls

There are different methods for estimating the degree of acoustic vari-
ation of the calls. These methods include call playbacks followed with 
analysis of behaviour of the focal recipient individual, as well as analy-
sis of vocalizations themselves. Analysis of vocalization can be qualita-
tive and quantitative. The quantitative analysis is based on measuring 
call parameters followed by some statistical procedures (just this work 
was done in the preceding Task 1). The qualitative analysis is based on 
the visual classifying the calls by human observers, relying their classifi-
cation on provided spectrograms or power spectra of referential calls or 
acting without the referential calls.
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Classic example of applying visual inspection for classifying calls is the 
describing the signature whistles produced by toothed whales (Odonto-
ceti). In this example, visual classifying of the whistles even when made 
by unexperienced humans, was more successful than classification based 
on the quantitative measurements of the acoustic parameters of the same 
whistles, because toothed whales often compress or expand their calls 
by keeping their characteristic pattern. Humans remember this pattern, 
whereas the statistical methods fail to resolve this problem. However, 
human classifying can be biased or depend on how much the person is 
informed about the tasks and what instruction were given to him/her 
before the start of the visual classifying task. All these things can strongly 
affect the obtained results and the conclusions made on their basis.

A lot of various mathematical models are currently available for vi-
sual classification, which allow a comparison of contours of particular 
calls, for example, by using the methods of cross-correlation or dynam-
ic time warping algorithm (Fig. 21). However, the practical work with 
such models is out of frames of this teaching course.

In any research, you can use both the visual and quantitative classifi-
cations together for obtaining more convincing results. But most studies 
use only one method for estimating the individual acoustic variation, 
as a rule, without reasoning for method selection. Only some studies 
compare the data obtained by different methods applied to the same 
call sample. Whereas selection of the method can substantially affect 
the results of the study, the knowledge of their powers and limitations 
is important for planning and conducting research. 

In this practical Task 2, we will compare the two methods of call clas-
sifying: the quantitative (using the results of discriminant analysis from 

Figure 21. Variants of comparison of call contours by using the cross-correlation 
(a) and dynamic time warping algorithms (b).
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the preceding Task 1) and the qualitative (classification made manually 
in frames of the current Task 2 using visual inspection of the calls). We 
will apply both analyses to the same call samples: of the ancient mur-
relet chicks and of the red-crowned crane chicks. Matched samples of 
call and equal number of individuals justify the statistical comparison of 
classifying success between the methods.

Task for the practical work.  
Part 1. Acoustics

For visual inspection of spectrograms of ancient murrelet and red-
crowned crane chick calls, you will receive the cards with spectrograms, 
with one call per card. A total of 72 calls per species should be subdi-
vided to 8 groups (corresponding to the 8 chicks) based on their image. 
For doing this task, you can use a ruler. The number of calls in each 
group can be different, but the number of groups should be obligatory 
eight. The calls can be inspected a few times; time for doing the task 
is unlimited. After classifying the calls to the eight groups, please turn 
the cards with face side down and then list the numbers of calls (writ-
ten on the back side) to a separate table. You can find the cards with 
calls and the referential table at link http://bioacoustica.org/practicum/
practicum_eng.html.

Task for the practical work. 
Part 2. Statistics

In the preceding task, we learned the opportunities of discriminant 
analysis for classifying the objects to a predicted number of groups. 
Now we should learn the limitations of discriminant analysis, which 
should be met to avoid obtaining the incorrect results. There are a few 
limitations on applying discriminant analysis:

1. Objects (observations) should belong to one of two (or more) class-
es (groups). Objects are the main units of analysis. Objects can be rep-
resented by humans, animals, countries etc.; here the objects are calls. 
In each class, should be at least two objects.

On practice, you will often meet the objects which cannot be at-
tributed to any group (for example, if calls of individually unidentified 
unsexed chick were recorded). Such objects cannot be immediately 
included in discriminant analysis, however, they can be classified lat-
er, on the basis of mathematical functions, obtained from analysis of 
objects with «known» individual and/or sexual identity. Discriminant 

http://bioacoustica.org/practicum/practicum_eng.html
http://bioacoustica.org/practicum/practicum_eng.html
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analysis calculates one or a few such functions (so-called discriminant 
functions) based on object characteristics and assign each object to 
one of the groups. After classifying the objects with known individual 
identities (as calls from individually identified chicks), cross-validation 
analysis can be applied, using the already calculated discriminant func-
tions for classifying the objects with unknown individual identity (as, 
for example, calls of an individually unidentified chick).

2. Characteristics of objects applied for separating the classes are 
named discriminant variables. Discriminant analysis does not work with 
qualitative variables. For applying discriminant analysis, the variables 
should be measured on either the interval scale, or on the ratios scale. 
Then, mathematical expectances and dispersions can be calculated so 
that using discriminant equations is becoming legitime. Generally, the 
number of discriminant variables is unlimited, but in sum, the number 
of objects should always exceed the number of variables at least by two.

3. Parameters used in discriminant analysis should not be the lin-
ear combinations of other variables (it is impossible to use the sum of 
variables of their arithmetic averages together with the variables them-
selves). Parameters whose correlation coefficient is equal to 1 are also 
inappropriate.

4. Distribution of each parameter should be normal.
These four limitations are essential for discriminant analysis. If the 

experimental data do not meet these assumptions, the obtained results 
cannot be considered as reflecting precisely the reality.

However, even if all the assumptions are met, the choice of parame-
ters has an important effect on the results of discriminant analysis. If 
the parameters are not linear combinations of each other but there is 
some degree of correlation between them, the final result (percent of 
classifying success) may be significantly overestimated. Nevertheless, 
the real sets of call parameters practically always, at least weakly, cor-
relate to each other (for example, the higher is the call minimum funda-
mental frequency, the higher, automatically, will be the call maximum 
fundamental frequency). The number of parameters used in analysis 
can also affect the final result. For controlling the effects of all possible 
factors and estimating the significance of the obtained percentages of 
correct assignment of the calls (to individuals, sexes, etc.) with discrim-
inant analysis, we should apply the so-called randomization procedure. 
The randomization procedure calculates by-chance percent of correct 
assignment (random value), which can be then compared with the real 
percent of correct assignment.

For calculating the random value, it is necessary to randomly mix 
the objects among groups (here, to mix the calls among the chicks), to 
conduct the discriminant analysis procedure and to repeated this ac-
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tion 1000 times. In the result, we will obtain the normal distribution 
of the random assignment value (Fig. 22), which can be used for com-
parison with the real percentage of correct assignment. For example, if 
distribution of the correct assignment value matches those presented 
on Figure 22, whereas the real percent of correct assignment is 22 % or 
more (on the figure, it is marked with a blue point), this would mean 
that it differs from the random distribution with probability p<0.001. 
In case if the real percent of correct assignment is 18 % (on the figure, it 
is marked with a red point), this would mean that it does not differ from 
the random distribution with probability p>0.05.

Step-by-step guide to the work with 
The R software

Please conduct the randomization procedure and check the result of 
discriminant analysis obtained in Task 1. For doing this, please repeat 
in R the actions described in Task 1 (conduct discriminant analysis of 
your own data). The sample code for the randomization procedure you 
can download also at link http://bioacoustica.org/practicum/practicum_
eng.html.

Figure 22. Histogram displaying the distribution of 1000 percentages of random 
assignment, calculated using randomization procedure. If the actual percent 
of correct assignment is 22 % (marked with a blue point), it differs from the 
random distribution with probability p<0.001. If the actual percentage of correct 
assignment is 18 % (marked with red point), it does not differ from the random 
distribution with probability p>0.05.

http://bioacoustica.org/practicum/practicum_eng.html
http://bioacoustica.org/practicum/practicum_eng.html
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1. After obtaining the results of discriminant analysis, please run the 
randomization procedure:

misclass <- function(pred, obs) {
tbl <- table(pred, obs)
sum <- colSums(tbl)
dia <- diag(tbl)
msc <- dia/sum * 100
m.m <- mean(msc)
m.m
}

output<-data.frame(atempt=NA, mean.perc=NA) 
for (i in 1:1000){
rand1<-sample(crane$Chick_N)
M7 <- lda(rand1~.,crane)
m.m<-misclass(predict(M7)$class, rand1)
output[i,1]<-i 
output[i,2]<-m.m 
}

To printout the results of the randomization procedure, use the com-
mand:

print(output) 

2. Calculate the descriptive statistics for the obtained distribution of 
1000 results of discriminant analysis:

average<-mean(output[,2]) 
cat(«Average m.m is «,average, «\n» ) 
sd<-sd(output[,2])
min<-min(output[,2])
max<-max(output[,2])
cat(«SD m.m is «,sd, «\n» )
cat(«Min m.m is «,min, «\n» )
cat(«Max m.m is «,max, «\n» )
sd<-sd(output[,2])

Now you can see the calculated average, maximal and minimal values 
for the by-chance percentage of correct assignment, along to standard 
deviation. Using this distribution, please compare it with the real per-
cent of correct assignment (in our example case, it was 97.5 %):

output[output$mean.perc>A,]

where A should be replaced with the real percent of correct assign-
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ment. As you can see, in our case there is no any single overlap between 
distribution of the by-chance value of correct assignment and the real 
percent of correct assignment, that is, the real result differs from the by-
chance value with probability p<0.001.

3. As an additional task we can create 3D graph of distribution of calls 
of our study chicks in the space of the three most important for classify-
ing discriminant functions. To do this, please indicate again the param-
eters which should be used for calculating the discriminant functions:

lda.fit <- lda(formula = Chick_N ~ F_beg + F_max + F_ext + F_end 
+ F_peak + Dur_beg-max + Dur_beg-ext + Dur_beg-end, data=crane)

Using the following function, you will calculate the position of each 
object (call) in the three-dimensional space of the three discriminant 
functions:

plda <- predict(object = lda.fit,
newdata = crane)

Please declare arbitrary the axes x, y and z as discriminant functions 
1, 2 and 3:

x <- plda$x[, 1]
y <- plda$x[, 2]
z <- plda$x[, 3]

Please declare arbitrary the colors for each individual:
mapdf <- data.frame(id=c(1,2,3,4,5,6,7,8), 
paint=c(«white»,»black»,»blue»,»red»,»green»,»yellow»,»pur-

ple»,»coral»)) 
colors <- mapdf$paint[match(crane$Chick_N,mapdf$id)]

Then please install the graphical packages of R (if they are not already 
installed on your computer):

install.packages(«rgl»)
install.packages(«magick»)
library(rgl)
library(magick)

Please set the size of labels on the figure:
viewport_size <- 512
par3d(windowRect=c(50, 50, 50+viewport_size, 50+viewport_

size))
par3d(zoom=1.1)

Then display the graph to the screen (Fig. 23):
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plot3d( 
x, y, z, 
col = colors, 
type = ‘s’, 
radius = .3,
xlab=»Function 1», ylab=»Function 2», zlab=»Function 3»)
play3d( spin3d( axis = c(0, 0, 1), rpm = 4), duration = 5 )

Additional information of how to start discriminant analysis of your 
data and what other results can be obtained is available at links https://
jcoliver.github.io/learn-r/003-intro-multivariate.html and https://rpubs.
com/ifn1411/LDA

Figure 23. Graph of distribution of analysed calls in the three-dimensional space 
using tree first discriminant functions. In this case, all the 8 individual red-
crowned crane chicks are included in analysis.

https://jcoliver.github.io/learn-r/003-intro-multivariate.html
https://jcoliver.github.io/learn-r/003-intro-multivariate.html
https://rpubs.com/ifn1411/LDA
https://rpubs.com/ifn1411/LDA
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Task 3.
Nonlinear phenomena in calls of 
mammals and birds. Measuring 

the fundamental frequency in calls 
containing nonlinear phenomena

Study objects

Mammals (adults)
Carnivora: red fox Vulpes vulpes, polar fox Vulpes lagopus, domestic 

dog Canis lupus familiaris, dhole Cuon alpinus; Cetacea: killer whale 
Orcinus orca.

Birds (adults)
Passeriformes: domestic sparrow Passer domesticus; Charadriiformes: 

puffin Fratercula cirrhata, crested auklet Aethia cristatella.

Birds (chicks)
Charadriiformes: puffin Fratercula cirrhata, crested auklet Aethia 

cristatella, horned puffin Fratercula corniculata, Gruiformes: Siberian 
crane Leucogeranus leucogeranus, red-crowned crane Grus japonensis; 
Strigiformes: Great grey owl Strix nebulosa; Sphenisciformes: Hum-
boldt penguin Spheniscus humboldti.

Aims of the work

1) to recognize different kinds of nonlinear phenomena in calls of 
mammals and birds; 

2) to determine the values of fundamental frequency in calls compli-
cated with presence of nonlinear phenomena.

Introduction. Kinds of nonlinear phenomena and 
why it is important to recognize them

There are many calls of complex structure (Fig. 24, 25), whose analy-
sis is difficult even for specialists. Nonlinear phenomena affect substan-
tially the acoustic structure of calls, by masking or entirely hiding the 
fundamental frequency band. This would result in mistaken classifying 
calls to the incorrect type and problems with measuring the fundamen-
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tal frequency or with selecting parameters for analysis of structural 
variation. So, you should learn how to find the fundamental frequency 
band, even if it is masked with different nonlinear phenomena.

Determining fundamental frequency band  
in calls produced by phonation

Mechanism for producing calls by vibration of the vocal folds (in mam-
mals) or syringeal membranes (in birds) is termed the phonation mode 
of vocal production. Call fundamental frequency (f0) corresponds to the 
vibration rate of vocal folds, visible as pulse rate at oscillogram. Call, 
produced by phonation mechanism, has a harmonic structure, that is, 
its spectrum contains power peaks not only of f0, but also of its integer 
multiple bands (harmonics: f1, f2 etc.). On spectrogram, harmonics rep-
resent frequency bands, lying above the f0 band, and their values are re-

Figure 24. Diversity of nonlinear phenomena in whines of red fox Vulpes vulpes. 
This call contains an articulation effect, deterministic chaos, subharmonics and 
frequency jump.

Figure 25. Diversity of nonlinear phenomena in calls of Humboldt penguin 
Spheniscus humboldti. This call contains an articulation effect and biphonation.
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lated to the f0 band values as whole numbers (2:1, 3:1 etc.). Oscillogram 
of normal phonation (that is, without nonlinear phenomena) represents 
a row of vibrations with constant period and amplitude (Fig. 26).

For measuring f0 at normal phonation, it is sufficient to measure the 
values of the lowest band of call frequency spectrum on spectrogram or 
to measure the duration of one vibrational period on oscillogram (the 
fundamental frequency can be further calculated by formula f0=1/Т). 
As a rule, the f0 band is the most accented band, bearing most energy 
and looking on spectrogram as the brightest frequency bands. In ide-
al case, Е(f0) = 2Е(f1) = 4Е(f2) etc., that is, the first harmonic band 
bears twice less energy than the f0 band, the second harmonic bears 
twice less energy than the first harmonic etc.. However, in reality, such 
«ideal» energy ratio does not occur, as sound of the vocal source (lar-
ynx, syrinx) is filtered by passing the vocal tract to output from the 
nose or from the mouth and then degrades at propagation through the 
environment (Fig. 26).

Determining the fundamental frequency 
in calls with nonlinear phenomena

Subharmonics
Sound source (vocal folds) represents a system of two coupled oscilla-

tors, which synchronize their vibrations during each cycle, ensuring the 

Figure 26. Spectrogram and oscillogram of a bark call of a crested auklet Aethia 
cristatella emitted in the mode of normal phonation. On spectrogram (left), the 
harmonic cursor indicates a position of the fundamental frequency band and its 
integer multiple harmonic bands. In the right window, a call fragment is shown 
indicated on spectrogram with a rectangular.
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periodical regular phonation. In case when vibratory modes of the vocal 
folds are substantially different (for example, when tension of one vocal 
fold is slightly stronger), coupling between them can result in synchro-
nizing of vibrations, but at different rate for each of the folds. So, for 
example, one vocal fold will pass two periods of vibrations during those 
time, when the second fold will pass only one period. On spectrogram 
(in this case) the intermediate frequency bands of 1/2, 1/3 or 1/4 steps 
between harmonics, termed subharmonics, will appear.

Subharmonics, as a rule, appear not for the duration of the entire calls 
uninterruptedly, what facilitates their recognition. To find the funda-
mental frequency in a call with subharmonics, it is necessary to find 
the frequency band, which would be the integer multiple to harmonics 
as 1:2, 1:3 etc., or would be integer multiple to subharmonics as 1:0.5, 
1:1.5 etc. or as 1:0.33, 1:0.66 etc.. Again, the fundamental frequency 
band is commonly the most accented band of a call, but there are ex-
clusions. Subharmonics can be discriminated from frequency jumps by 
oscillogram: the oscillogram of the subharmonic mode clearly displays 
a regular alternation of the high and low-amplitude peaks (Fig. 27).

Deterministic chaos
This nonlinear phenomenon results from aperiodic, irregular vibra-

tions of the vocal folds. However, in spite of the chaotic character of 
the vibrations, the vocal folds still behave as coupled oscillators, re-
taining the mechanic and aerodynamic relationship to each other. As 

Figure 27. Spectrogram and oscillogram of a red fox Vulpes vulpes whine call 
produced in the subharmonic mode. On spectrogram (left), the harmonic cursor 
indicates the position of the fundamental frequency band and its integer multiple 
harmonic bands. In the right window, a call fragment is shown indicated on 
spectrogram with a rectangular.
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the result, the aperiodic vibrations are arranged around some average 
frequency which commonly corresponds to the call fundamental fre-
quency. On spectrogram, deterministic chaos looks like rather uniform 
darkness of the entire spectrum, with residual energy in the area of 
the fundamental frequency and its harmonics (Fig. 28). This allows 
to reliably distinguish this variant of vibratory mode of the vocal folds 
from the turbulent noise, which also looks as uniform darkness of the 
entire spectrum, but at which the vocal folds do not work, and the 
air is blowing under press through the glottic or the narrowing of the 
vocal tract.

Measuring the fundamental frequency in a call with deterministic 
chaos is often difficult. Commonly, the fundamental frequency run can 
be predicted by power peaks which correspond to the fundamental fre-
quency and its harmonics, but only in cases when the degree of desyn-
chronization of the work of the vocal folds is not too strong (Fig. 28). In 
addition, the calls with deterministic chaos can contain the «frequency 
windows» with fragments of normal phonation, when the vocal folds 
return for some time to the work in the coupled mode (Fig. 29а). These 
«windows» commonly facilitate the search of the fundamental frequen-
cy in a call. However, in cases when the degree of desynchronization in 
the work of the vocal folds is high, determining the fundamental fre-
quency of a call can be impossible (Fig. 29b).

Figure 28. Spectrogram and oscillogram of Humboldt penguin Spheniscus 
humboldti chick call produced in the deterministic chaos mode. On spectrogram 
(left), the harmonic cursor indicates a position of the fundamental frequency 
band and its integer multiple harmonics. An approximate position of the 
fundamental frequency band is indicated by power peak at the area of 2 kHz. 
In the right window, a call fragment is shown indicated on spectrogram with a 
rectangular.
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Frequency jumps
The nonlinear phenomenon frequency jump represents an abrupt 

change of fundamental frequency within one cycle of vibration. Fre-
quency jumps may occur within one sound source (vocal folds) or be-
tween two different sound sources (Fig. 30). Sometimes it is difficult to 

Figure 29. Spectrogram of parakeet auklet Aethia psittacula chick calls in 
the deterministic chaos mode. The first call (a) contains «windows» with 
normal phonation at the beginning and at the end, where the position of the 
fundamental frequency and its integer multiple harmonics is visible; the second 
call (b) does not contain the «windows» with normal phonation, so determining 
the fundamental frequency is difficult.

Figure 30. Spectrogram and oscillogram of red-crowned crane Grus japonensis 
fledging call with frequency jump. On spectrogram (left), the harmonic cursor 
indicates the position of the fundamental frequency and its integer multiple 
harmonics at the beginning of the call. In the right window, a call fragment is 
shown indicated on spectrogram with a rectangular.
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distinguish between frequency jumps and subharmonics (if the change 
of fundamental frequency in the frequency jump occurs by integer mul-
tiple ways relative to preceding fundamental frequency). In such case, 
it is convenient to use again the oscillogram. In case of frequency jump, 
oscillogram always clearly displays an abrupt change of vibration rate 
from one mode to another (Fig. 30), whereas the oscillogram of the sub-
harmonic mode displays a regular alternation of the high and low-am-
plitude peaks (Fig. 27).

Two independent frequencies in the call (biphonation in a broad sense)
Biphonation appears when two independent fundamental frequen-

cies are present within a call. There are three patterns of biphonations, 
which cannot be discriminated physically (because in all the cases, 
there are two independent fundamental frequencies within call, in-
teracting to each other), but they differ in the pattern of displaying on 
spectrograms. Even by spectrogram, these patterns are not always well 
distinguishable from each other, and the intermediate forms between 
them are relatively widespread. In such cases, it is better to speak about 
biphonations in a broad sense, without concentrating attention on the 
particular pattern of biphonation.

1. Sidebands. In case when the difference between two independent 
fundamental frequencies is large (over 1 kHz), one of the frequencies 
is rather low, and the interaction between these two frequencies re-
sults in the appearance of an additional amplitude modulation, we ob-
serve the pattern termed sidebands. In calls with sidebands, the low 
fundamental frequency can be invisible in call spectrum, being filtered 
out by the vocal tract. Thus, we observe on spectrogram only the up-
per fundamental frequency and the combinatory frequency bands (re-
sulting from interaction between the two fundamental frequencies of 
a call), looking as bands spreading up and down from the fundamen-
tal frequency band and the bands of harmonics, with step between 
the combinatory bands equal to the frequency of amplitude modula-
tion. The sidebands which are nearest to the fundamental frequency 
band and harmonics are most accented energetically and fade more 
and more with increasing distance from them. As amplitude modula-
tion can change for the duration of a call, the step between sidebands 
will increase or decrease respectively, what allows to distinguish them 
from subharmonics, which are integer multiples of fundamental fre-
quency throughout a call. Sidebands can also be easily distinguished 
from the classical biphonations and subharmonics by call oscillogram, 
displaying clearly both the fundamental frequency period and modu-
lating frequency period (Fig. 31). Commonly, calculating fundamental 
frequency in a call with sidebands is not difficult (most often, this is 
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the brightest band in call spectrum), but sometimes, sidebands practi-
cally entirely mask the fundamental frequency. Then, it is possible to 
calculate it by oscillogram by the formula f=1/Т.

2. Biphonation (in narrow sense). At biphonation, two independent 
fundamental frequencies and the results of their interaction are visible 
in call spectrum (Fig. 32). The difference between two independent 
fundamental frequencies is rather large (not less than 1 kHz). Com-
monly, you can see, on spectrogram, two non-integers to each other fre-
quency bands (f0 и g0) with independent contours of frequency modu-
lations, and each frequency has its own harmonics (f1=2f0, f2=3f0 etc., 
g1=2g0, g2=2g0 etc.). Moreover, these frequencies interact to each 
other with creating the linear combinatory frequencies (g0-f0, g0-2f0) 
(Fig. 33). By presence in the spectrum of the independent frequencies 
with their harmonics and combinatory frequency bands, biphonation 
can be easily distinguished from other nonlinear phenomena. On oscil-
logram of the biphonation in narrow sense, the amplitude modulation 
is commonly invisible.

3. Beating. This nonlinear vocal phenomenon results from interaction 
of two independent fundamental frequencies with similar values (with 
differences less than 1 kHz). Call oscillogram at beating arises by arith-
metic summation of values of the two sinusoids corresponding to each 
of the fundamental frequencies in each point, so, as in the case of side-

Figure 31. Spectrogram and oscillogram of red-crowned crane Grus japonensis 
fledging call with sidebands arising due to the additional amplitude modulation 
of fundamental frequency. On spectrogram (left), the harmonic cursor indicates 
the position of fundamental frequency and its integer multiple harmonics. In 
the right window, a call fragment is shown indicated on spectrogram with a 
rectangular.
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bands, on the oscillogram, we observe amplitude modulation (Fig. 34). 
Theoretically, at beating, call spectrum should lack the additional fre-
quency bands, but in reality, we see, rather often, not only two funda-
mental frequencies, but also their steadily fading combinatory frequen-
cies. The beating can be easily distinguished from subharmonics, as two 
frequencies commonly have independent run from each other, whereas 
subharmonics are always parallel. The beating can be easily confused 

Figure 32. Spectrogram and oscillogram of Siberian crane Leucogeranus 
leucogeranus fledging call with biphonation. In the right window, a call fragment 
is shown indicated on spectrogram with a rectangular.

Figure 33. Power spectrum of call fragment containing biphonation, indicated 
on spectrogram with a rectangular on the figure 32; f0 — the upper fundamental 
frequency, g0 — the low fundamental frequency, 2f0, 2g0, 3g0 — harmonics 
of the upper and low fundamental frequencies; f0+g0, f0+2g0 — combinatory 
frequencies.
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with sidebands by call oscillogram, on which also commonly well visible 
both the fundamental frequency period and the modulating frequency 
period (Fig. 34), but in a call with sidebands, as a rule, one most bright 
band is visible, with coming up and down steadily fading additional fre-
quency bands, whereas in the call with beating, two close fundamental 
frequencies are always well-visible, whereas the additional frequency 
bands are expressed weaker or even can be missing (Fig. 34).

Thus, biphonations in narrow sense, beatings and sidebands repre-
sent different poles of the same physical phenomenon; differences be-
tween them can be summated by the following scheme (Fig. 35).

Figure 34. Spectrogram and oscillogram of Siberian crane Leucogeranus 
leucogeranus fledging call with beating. In the right window, a call fragment is 
shown, indicated on spectrogram with a rectangular.

Figure 35. Differences between biphonations, beating and sidebands.
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Task for the practical work

The calls intendent for analysis are recorded from young and adult in-
dividual mammals and birds. The 17 files with recordings can be down-
load at link http://bioacoustica.org/practicum/practicum_eng.html; file 
names correspond to the task numbers. Each file contains 2–4 calls 
from one individual of a given species, intervals between calls were cut 
off for more convenient analysis. In the task description you will find a 
precise location of the time fragment of the call which should be used 
in the work. 

Inspect visually the 17 files with recordings. Please determine, what 
acoustic mode is attributive for each of these proposed calls (normal 
phonation, subharmonics, deterministic chaos, frequency jump, side-
bands, biphonation, beating). Please determine the values of call maxi-
mum fundamental frequency on the marked time fragments (for bipho-
nations and beatings, please determine the maximal values for each of 
the fundamental frequencies):

File 
name

Call number 
within file

Time fragment 
for analysis (s) Species

1 second 1.32–1.52 red fox Vulpes vulpes

2 first 0.13–0.26 red fox Vulpes vulpes

3 third 0.75–0.77 domestic sparrow Passer domesticus

4 second 1.00–1.20 domestic dog Canis lupus familiaris

5 first 0.15–0.20 crested auklet chick Aethia cristatella

6 first 0.83–1.17 tufted puffin chick Fratercula cirrhata

7 second 2.64–3.00 Siberian crane chick Leucogeranus leucogeranus

8 first 0.21–0.51 horned puffin chick Fratercula corniculata

9 first 0.40–0.45 Humboldt penguin chick Spheniscus humboldti

10 first 0.16–1.00 tufted puffin Fratercula cirrhata

11 forth 1.65–1.85 crested auklet Aethia cristatella

12 first 0.65–0.90 horned puffin chick Fratercula corniculata

13 first 0.24–0.25 dhole Cuon alpinus

14 first 0.5–0.6 killer whale Orcinus orca

15 second 0.45–0.59 great grey owl chick Strix nebulosa

16 first 0.50–0.60 polar fox Vulpes lagopus

17 first 0.32–0.35 red-crowned crane chick Grus japonensis

http://bioacoustica.org/practicum/practicum_eng.html
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Important!!! At measuring frequency in the labeled call fragment, do 
not zoom the call so strongly to have in the window only the labeled frag-
ment. At such extending, the sound will be visible very unclearly. It is bet-
ter to select the degree of extension at which the call will be visible on the 
screen entirely, but the measurements should only be done for the labeled 
fragment, because the fundamental frequency is changing strongly for the 
duration of the call, so the obtained values can differ strongly depending 
on the selected point of measuring.

Guidelines to the work with  
Avisoft-SASLab Pro

For making this task, use all the three windows of Avisoft: oscillo-
gram, spectrogram and power spectrum. For creating spectrogram, 
select in the spectrogram window Analyze → Create Spectrogram. For 
creating spectrogram, use each time the most appropriate parameters 
for creating spectrogram for the calls of the given pattern. In order to 
change them, please select Analyze → Spectrogram parameters; from 
the proposed parameters, try to change only «Overlap» and «Frame 
Size», ensuring resolution in time and frequency. For creating the de-
tailed frequency spectrum, please click with mouse two times on the 
panel of frequency spectrum in the spectrogram window (preliminary, 
select with the standard cursor in the spectrogram window only the 
necessary call fragment, otherwise the spectrum will be created for 
the entire call). For finding the harmonics, integer multiples of funda-
mental frequency, it is convenient to use the special harmonic cursor 
(spectrogram window: Tools → Cursors → Insert harmonic frequency 
cursor; the power spectrum window: the harmonic cursor is «pulling» 
with mouse from-under the у axis). In the spectrogram window, you 
can use only one harmonic cursor, whereas in the window of power 
spectrum there are two cursors, what can be convenient at analysis of 
biphonations.
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Task 4.
Vocal repertoires and methods of call 

classifying. Advanced options of Avisoft-
SASLab Pro (automatic call parameter 
measuring, call labeling, filtering etc.) 
and the essential options of Syrinx and 

Audacity software  
(visual inspection and call labeling)

Study objects

Mammals (adults)
Rodentia: yellow steppe lemming Eolagurus luteus.

Birds (adults)
Passeriformes: Siberian blue robin Luscinia cyane.

Birds (chicks)
Gruiformes: common crane Grus grus.

Aims of the work
 
1) to describe the vocal repertoire of three animal species based on 

provided audio recordings of calls sequencies;
2) to conduct the automatic measuring of the selected for analysis 

calls from the three species using three different kinds of software for 
bioacoustical analysis.

Introduction. Vocal repertoires and why their 
describing is important?

Any study of acoustic behaviour of animal species starts with de-
scribing the vocal repertoire. If the vocal repertoire was not already 
described in literature, you should start with creating a simple and con-
venient scheme describing variation of calls of the given species. Based 
on this scheme, you can subdivide the vocal repertoire to call types. For 
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describing the vocal repertoire, it is necessary to collect a representa-
tive sample of calls from several individuals of the given species (and, 
desirably, at different age classes) in different contexts (e.g., during 
social contacts with conspecifics, during courtship and aggressive in-
teractions, during communication with offspring/parents, in situation 
of food deficit, cooling, etc., depending on species biology). Then, the 
recorded calls should be classified to call types.

For describing the vocal repertoires of mammals and birds, two ap-
proaches of classifying can be applied: by structure and by functions. 
Avoid mixing these two approaches, but when applied one after anoth-
er, they complete each other very well.

At classifying calls by function, the main attention is focused on rela-
tionship of calls with certain behaviour, e.g., calls can be subdivided to 
categories attending comfort, aggression, appeasing, sexual or mater-
nal behaviour.

At classifying calls by the acoustic structure, the main attention is only 
focused on physical parameters of the calls. In this case, calls are sub-
divided to structural classes, for example, tonal or noisy, with rhythmic 
or without rhythmic etc., and further divided accordingly to greater 
detail within each structural class. Fragmentation of classifying is arbi-
trary given by researcher depending on the particular research task, so 
the number of call types to which the repertoire is subdivided can vary 
broadly, from a few to a few dozen call types.

At classifying by structure, sometimes it is difficult to strictly discrim-
inate call types from each other. There are intermediate forms, so that 
call types, from one side, represent discrete units, but from another 
side, all vocalizations, due to intermediate forms, may represent one or 
a few structural continua.

Call classifying to types primarily based on the following criteria:
1.	 Source of sound production. Calls can be subdivided to groups 

on the basis of sound production. For example, the voice calls 
produced by phonation with self-sustained vibration of the vo-
cal folds, the hiss calls, produced by aerodynamic turbulence, 
the whistle calls, produced by aerodynamic jet or edge-tone 
mechanism and purring calls, produced by muscle activity 
applied to the vocal folds (e.g., cat purring at both phases of 
breathing).

2.	 Presence or absence of rhythmicity.
3.	 Duration of vocalization.
4.	 Contour of frequency modulation.
5.	 Presence or absence of some nonlinear phenomena.
Variation of duration or frequency modulation and presence of non-

linear phenomena can be different for different call types. The degree 
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of possible variation is determined by researchers themselves basing on 
the aims of the study and peculiarities of certain species. However, to 
make the classification reproducible by other researcher, it is import-
ant to precisely describe in the methods, which borders were arbitrary 
selected between call types. Verifying the own classification is possible 
by using the statistical procedure of discriminant analysis. Discriminant 
analysis clearly demonstrates how realistic the established borders be-
tween call types are.

Suggestions for practical work. 
Part 1. Avisoft-SASLab Pro

Advantages of Avisoft-SASLab Pro software
In the last years, many researchers throughout the world conduct 

bioacoustical studies, so the number of bioacoustical programs in-
creases constantly. Today, you can find many bioacoustical programs 
with different capacities at different prices (from available for free to 
very expensive). Choice of most appropriate and convenient soft can 
be difficult. With Avisoft-SASLab Pro, we made the Tasks 1 and 3; in 
current task 4, we will evaluate some special options of Avisoft and 
will additionally consider two other bioacoustical programs, Syrinx 
and Audacity.

First versions of Avisoft-SASLab Pro were developed by German spe-
cialist Raimund Specht in 1990th. Now Avisoft is one of most used pro-
grams for bioacoustical studies. New versions of Avisoft appear regu-
larly. The program is convenient and user-friendly, allowing to conduct 
various measurements manually and automatically, create high-resolu-
tion spectrograms and oscillograms, label and filter the calls etc. How-
ever, Avisoft has some limitations: it can only be installed on computers 
with Windows, works with only files of particular formats (.WAV .BWF 
.AIF, .SND, .AU) and is not available for free.

In the current Task 4, we will learn the abilities of Avisoft for labeling 
and selection of calls for analysis, including the automatic call parame-
ter measuring.

Guidelines for individual work
Inspect visually the file Common crane.wav in Avisoft; make the visu-

al classification of call types occurring in this file; describe them shortly 
in the attending file with comments or provide their spectrograms in 
a separate textual file. Using markers of Avisoft, label 10–15 calls per 
call type in the audio file. Export the labeled calls to separate files, one 
file per call type. Save the prepared files. Conduct the measurements 
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of 10 calls per call type using the panel for the automatic call measure-
ments in Avisoft; check whether data export is functioning normally 
and provides the adequate values of call measurements; save the ob-
tained Excel table.

Step-by-step guidelines to the work with Avisoft-SASLab Pro
1. Please run Avisoft and open the audio file; inspect visually the re-

cording. If necessary, make call downsampling to 11025 Hz (Edit → 
Format → Sampling frequency conversion), filter out the alien low-fre-
quency noises (Edit → Filter → High pass IIR filter → select the low-fre-
quency zone which should be filtered out from the file, for example 
1 kHz). Tune out, with most convenient for you way, the parameters 
for visual inspection of spectrograms (Analyze → Overview parame-
ters), for example, try to change the settings of FFT-length, Frame and 
Threshold and observe how this will affect the quality of spectrogram in 
the main window of Avisoft.

2. Make the visual classification of call types occurring within the 
file. Describe shortly the distinctive traits and basic characteristics of 
each call type. Using the markers of Avisoft (Tool → Labels → Insert 
section label from marker), label 10–15 calls of each type. At labeling, 
for each call type, use different layers (layer 1, layer 2 etc.). For conve-
nient work, you can set the «hot key» on the keyboard, in order to add 
the marker by pressing the key. Do it using Actions → Keyboard Short-
cuts and Popup Menu. In the opened window, select the convenient 
for you key on the keyboard by putting the checkmark against Tool … 
Labels … Insert section label from marker, for example, «2». Please ex-
port the labeled calls to separate files depending on call type (Tool → 
Labels → Save labeled sections of the same class into single wav file). 
Save the obtained files.

3. Open one of the obtained files and create the spectrogram using 
the most convenient for your parameters for creating spectrogram 
(Analyze → Spectrogram parameters; for example, FFT-length 1024, 
Frame size 25, Overlap 98.43).

4. In the spectrogram window, establish the set of parameters for the 
automatic measurements. Select from the main menu of the spectro-
gram window Tools → Automatic parameter measurements → Auto-
matic parameter measurements setup. This will open the window, in 
which you can select the acoustic parameters for measurements. Select 
the acoustic parameters for measurements, for example, as it is indicat-
ed on Figure 36.
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Figure 36. Window in Avisoft-SASLab Pro for selecting parameters for the 
automatic measurements. The way of filling this window is in accordance to the 
aims of the practical task 4.

Figure 37. Spectrogram (right) and power spectrum (left) of a call of a yellow 
steppe lemming Eolagurus luteus, illustrating some measured parameters that 
mentioned in the text.
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When you selected the settings as indicated on Figure 36, please la-
bel the call with the standard cursor and select the command «Copy 
parameter measurement values» (in spectrogram menu, select Tools → 
Automatic parameter measurements → Copy parameter measurement 
values). The following parameter values will be exported to the exter-
nal file:

1)	 duration of the labeled fragment (duration, Fig. 37);
2)	 peak frequency of the labeled fragment (F_peak, Fig. 37);
3)	 minimum and maximum frequencies of a power peak at the lev-

el -10dB from the point of a call power maximum (bandw_min, 
bandw_max, Fig. 37);

4)	 the wide of power peak at level -10dB from the point of a call 
power maximum (bandwidth);

5)	 three power quartiles of a call, displaying the frequencies, lower 
which are disposed 25, 50 and 75 % of call energy respectively 
(Q25, Q50 and Q75, Fig. 37);

6)	 call entropy (Entropy), reflecting the degree of call noisiness (this 
value varies from 0 to 1, where the values around 0 characterize 
practically ideal tonal call, whereas the values around 1 charac-
terize, otherwise, practically white noise.

According to the settings shown on Figure 36, all parameters aside the 
duration of the labeled element will be measured by a program for the 
following locations:

1)	 for the beginning and end of the element;
2)	 for the middle of the element;
3)	 in the point of the maximum call intensity (or in the point of max-

imum amplitude);
4)	 and, at last, for the entire call spectrum.
As you can see on Figure 36, the listed parameters can also be taken 

from the entire call contour, for example, by «cutting» it to the given 
number of equal sections or with the given time interval. This is useful, 
for example, for those tasks, where the entire contours of calls are com-
pared.

5. Prepare the Excel file, to which Avisoft will automatically export 
the measured parameters (for example, use the table Prim2, which can 
be downloaded together with audio files for the given Task 4 at link 
http://bioacoustica.org/practicum/practicum_eng.html). In the spectro-
gram window of Avisoft, establish the settings for export of measured 
parameters (see also Fig. 14). For this, select File → Data export  → 
DDE-Parameters/Log-File.

In the appeared window, you need:
1)	 first, fill the field «Topic» (the name of your Excel file);

http://bioacoustica.org/practicum/practicum_eng.html
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2)	 then, in the field «Item», indicate the cell of your Excel table, to 
which the program should copy the first measurement (R — line, 
C — column); next measurements of the same call Avisoft will 
copy to the same line, one after another;

3)	 at last, indicate, after how many clicks (measurements) Avisoft 
should hop to a new line (that is, how many measurements of 
each call you are going to make); in our case, the measurement 
will be only one (one click on the labeled with the standard 
marked cursor call).

6. Copy the names of measured parameters to the prepared Excel ta-
ble. For doing this, select in the spectrogram window Tools → Automat-
ic parameter measurements → Copy parameter measurement headings. 
If export parameters are tuned correctly, Avisoft should copy the names 
of the proposed for measuring parameters to the first line of Excel table. 
Now you can start the measurements.

7. For measuring, label the call with the standard marker cursor from 
the beginning to end in the spectrogram window and select Tools → 
Automatic parameter measurements → Copy parameter measurement 
values. For convenience of measuring, you can set the «hot key» to this 
command, then the measurement will be made at pressing the partic-
ular key on the keyboard. For setting the «hot key», select in the spec-

Figure 38. Spectrogram window in Avisoft-SASLab Pro illustrating the using the 
manual filter «Eraser» for removal the alien noise complicating call analysis.
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trogram window Tools → Keyboard Shortcuts and Popup Menu. In the 
opened window, checkmark the convenient for you key of the keyboard 
against Tools → Automatic parameter measurements → Copy parame-
ter measurement values, for example, 1. Then, for measuring the call, 
it is sufficient to label it with the standard marker cursor and press the 
key «1» on the keyboard.

8. Make the measurements on 10 calls of two main call types; check 
whether the program is working normally and displays the adequate 
values. If the call is strongly polluted with noise, clean it manually of 
the alien noise, because the selected power parameters are very sensi-
tive to the pollution. For the cleaning, you can select the manual filter 
«Eraser» from the buttons in the spectrogram window (Eraser cursor 
style, Fig. 38).

Suggestions for practical work. 
Part 2. Syrinx

Advantages of Syrinx software
Distinctive to Avisoft, the Syrinx program is free available, but the 

author of Syrinx (John Burt) asked to refer on him in papers. The pro-
gram was created in 1995. Syrinx was actively applied in 90-th for 
analysis of bird songs, however, in the last years, it was not upgrad-
ed. In spite of the prolonged absence of upgrades, Syrinx works with 
all versions of Windows and with files of different types, including 
the formats wav and mp3. Syrinx allows creating call spectrograms 

Figure 39. Spectrogram of Siberian blue robin Luscinia cyane songs, with labeling 
at different levels using Syrinx (a) and the textual file with automatically exported 
parameters (b).
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and conducting express-analyses, including the visual inspection of 
recordings, catalogizing the calls using a convenient labeling option, 
measuring the essential call parameters (call duration and the maxi-
mum and minimum fundamental frequencies). The measured values 
are exported to the textual file. However, power parameters cannot be 
measured with Syrinx.

One important advantage of Syrinx is a possibility to easy and con-
veniently label the recordings at different levels. The measured param-
eters of the labeled calls are automatically exported to the textual file 
(Avisoft does not allow to conduct the labeling and measuring param-
eters simultaneously; Fig. 39). Measuring parameters with Syrinx can 
also be conducted without the labeling. In this mode, the values will 
also be automatically exported to a textual file. In frames of this Task 
4, we will know about the labeling calls with Syrinx for further analysis 
and with automatic measuring call parameters.

Suggestions for practical work
Inspect visually the file Siberian blue robin.wav in Syrinx program. 

Classify visually the song types present in the file. Describe shortly 
the distinctive and basic characteristics of each song type or provide 
their spectrograms in a separate textual file. By using the markers of 
Syrinx, label the songs in the file minding their type; then save the 
obtained file-annotation with measurements of the song types. Ex-
port the obtained measurements of the song types to Excel. Calculate 
with Excel the Mean ± SD for each of the measured parameters in 
each song type.

Step-by-step guidelines to the work with Syrinx
1. Start the Syrinx and open the audio file Siberian blue robin.wav. 

By selecting from menu View → Make Time Scale Fit Window you can 
zoom a small fragment of recording to the entire screen; if you need 
the higher or less resolution, use the commands View → Zoom In / 
Zoom Out. For increasing / decreasing the brightness of the image, use 
View → Make Spectrogram darker / Make Spectrogram lighter. Combi-
nation of the keys «Shift + C» will allow to reproduce the selected frag-
ment of recording. Command Edit → Copy Bitmap of Current Window 
will allow to copy the spectrogram to the external sources.

2. Inspect visually the recording. Create a visual classification of song 
types occurring in the file. Briefly describe the distinctive and basic 
characteristics of each of the song types. Using the markers of Syr-
inx, label the songs in the file (Tool → Annotation → Add Annotation 
Link → indicate the place of storage and the name of the forming meta-
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file and we obtain a separate metafile with labeling and comments). At 
labeling, contour accurately each call type so that the borders of the 
rectangular would pass through the minimal and maximal values of 
song frequencies, as well as the beginning and end of the vocalization. 
In such case, the created metafile will contain the actual values that 
can be used for the statistical analyses of parameters of vocalizations 
(the minimum and maximum values of sound frequencies, time of the 
beginning and end of sound). After the contouring, press the key «En-
ter» for exporting the measurements to metafile. Please label (by catal-
ogizing simultaneously song types and measuring their parameters) all 
songs in the file, save the obtained file-annotation with measurements 
of all present song types. Export the obtained measurements of song 
types to Excel.

For convenient visual inspection of long spectrograms, select, in the 
section Options: Window Display Settings and then select the Number 
of display rows equal to 4. Then, on monitor, the spectrogram will be 
shown in a few lines, that can be convenient for comparative analysis 
of call structure. In the same section, it is possible to zoom the spec-
trogram image on the entire screen (the values of frequency should be 
indicated in Hz).

Suggestions for practical work.  
Part 3. Audacity

Advantages of Audacity program
As Syrinx, the Audacity is free available software, but it is much 

more modern program (developed by the group Foos.Hub). As Syr-
inx, the Audacity allows creating call spectrograms and conducting ex-
press-analyses, including visual inspection of recordings, catalogizing 
calls using a convenient option of labeling and measuring the temporal 
parameters. The measured values are exported as a text file. However, 
the frequency and power parameters are unavailable for measuring. 
The Audacity is compatible with platforms Windows, Mac and Linux 
as well as with files of different types, including the wav and mp3 for-
mats. In frames of this Task 4, we will familiarize with possibilities of 
Audacity for labeling calls for further analysis and with automatic mea-
suring their parameters.

Suggestions for practical work
Inspect visually the file Yellow steppe lemming.wav using the pro-

gram Audacity. Make the visual classification of call types occurring 
in the file. Describe shortly the distinctive and basic characteristics of 
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each of the call types or provide their spectrograms in a separate textual 
file. Using markers of Audacity, label 10–15 calls of each type, save the 
markers in the textual file-annotation. Export the obtained measure-
ments of calls types to Excel. Calculate in Excel Mean ± SD for each of 
the measured parameters in each call type.

Step-by-step guide to the work with Audacity software
1. Start the Audacity program (available for free downloading at link 

https://www.audacityteam.org/) and open the audio file (for example, 
Yellow steppe lemming.wav) from Menu: File → Open. In the opened 
file, the main window is looking as illustrated on Figure 40 (at the ini-
tial stage, you will only see the oscillogram of the audio file).

2. In the left window (marked with red arrow on Fig. 40), press the 
panel with file name and arrow down; select «Spectrogram». The pro-
gram will create the spectrogram of the entire file. Click with mouse 
on the lower border of spectrogram and extend it down to the borders 
of the screen. Again, in the left window (arrow-marked), press the box 
with the file name and, with pressing the arrow down, select «Spec-
trogram settings». For choosing most convenient parameters for visual 

Figure 40. The main working window of Audacity. The working field described 
above in the text, is marked with red arrow.

https://www.audacityteam.org/
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inspection of the calls, try to manually change the parameter values, 
e.g., «Scale», «Window size» or «Scheme». Example set of parameters 
appropriate for ultrasounds of yellow steppe lemmings is shown on 
Figure 41.

Important!!! Example settings indicated on Figure 41 are specially se-
lected for the ultrasonic calls of yellow steppe lemmings. You can try to 
change them and to look for the result (for training). For other species 
with different characteristics of the calls, the settings should be selected 
separately.

3. Now you can train to scale the file on time axis using the keys with 
loupe images (Fig. 40), to playback some fragments of recording. You 
can try to edit the file (select from Menu Edit → Copy / Paste etc.). The 
program allows to open many windows (files) in one time, what is con-
venient for the visual confronting of calls of different animals.

A zoomed fragment of the file Yellow steppe lemming.wav with indi-
cated spectrogram settings and scaled in time can look as it is shown on 
Figure 42.

4. As you can see, Audacity creates spectrograms of sufficient quality 
for visual inspection and catalogizing of recordings, and for describing 
the vocal repertoires of particular species. In addition, Audacity allows 

Figure 41. Example set of parameters for creating spectrogram of a yellow steppe 
lemming Eolagurus luteus ultrasonic call.
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Figure 42. Main working window of Audacity, displaying spectrogram of yellow 
steppe lemming Eolagurus luteus calls.

Figure 43. Main working window of Audacity, illustrating two labeled calls of 
yellow steppe lemming Eolagurus luteus.
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labelling the selected calls and conducting measurements of call du-
ration.

With mouse cursor, label the selected call with maximum accuracy 
from the beginning to end. Then select from Menu: Edit → Labels → 
Add Label at Selection. In the window that appeared under spectro-
gram, write the name of call type which you assign to calls of such struc-
ture (for example, «Type 1»; Fig. 43).

5. After adding all labels, you can save time marks for each call to the 
textual file. For this, select File → Export → Export Labels, and write 
the name for the textual file. Time marks of the beginning and end of 
the selected sections and the names of the call types will appear in the 
list (Fig. 44). The file can then be opened with Excel, by converting it to 
the respective Excel format, and then you can calculate, basing on the 
obtained time marks, the mean durations of all call types.

Figure 44. Textual file of Audacity program with automatically exported call 
parameters at conducting the marking procedure.



66

Task 5.
Tracking and measuring call fundamental 

frequency and formants with Praat

Study objects

Mammals (adults)
Artiodactyla: three subspecies of red deer (Cervus elaphus hippela-

phus, C. e. hispanicus, C. e. sibiricus), goitred gazelle (Gazella subguttur-
osa), saiga (Saiga tatarica).

Aims of the work

1) to track and measure call fundamental frequency;
2) to track and measure the frequencies of the first four (lowest) for-

mants in calls of three ungulate species.

Introduction. The vocal systems  
of terrestrial vertebrates

In all terrestrial vertebrates, the vocal systems are arranged according 
to the general scheme and consist of three parts: the lungs, the sound 
source and the vocal tract. The lungs create the airflow which provides 
energy for sound production. Sound source (the larynx in mammals 
and the syrinx in birds) transforms the energy of the airflow to the 
acoustic energy, and creates the sound wave. The rate of vibration of 
the vocal folds (in mammals) or of the syringeal membranes (in birds) 
corresponds to call fundamental frequency.

Sound wave created by sound source passes through the volumes of 
the vocal tract: throat, mouth and/or nose, and, in birds, additionally 
via the trachea (because bird syrinx is positioned lower than the mam-
malian larynx, namely in the place of the trachea branching to the two 
bronchi). The vocal tract modifies the sound, working as the acousti-
cal filter re-distributing sound energy, with accenting it in the area of 
the resonance frequencies (formants) for the account of the weakening 
the energy in the area of anti-resonances, thus changing the structure 
and sounding of calls created with sound source. As sound source of all 
terrestrial vertebrates is positioned inside the body, the output sound 
signal is always the result of work of both the source and the vocal tract.
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Along to call duration and fundamental frequency, the formant fre-
quencies represent the essential acoustic parameters which encode in-
formation about the caller: physical size, age, sex, physiological status 
(aggressivity, fear, motivation), emotional state (degree of discomfort, 
degree of arousal, emotional valence), individuality and species-specif-
ic traits. So, acoustic parameters related to the fundamental frequen-
cy and formants are measured in many bioacoustical studies. Modern 
methods of call analysis allow measuring the acoustic parameters relat-
ed to both sound source (fundamental frequency) and vocal tract (for-
mant frequencies).

All programs for call analysis we used so far (Avisoft, Syrinx, Audacity), 
only allow measuring parameters of fundamental frequency and dura-
tion. For transforming the sound wave to call spectrum, these programs 
use Fast Fourier Transform (FFT). However, for calculating the formant 
frequencies, another algorithm of sound wave transforming to call spec-
trum is necessary, the Linear predictive coding (LPC). The LPC algorithm, 
along to FFT, well-realized only in one program for sound analysis, the 
Praat, which was initially created for analysis of human speech.

Task for the practical work

Inspect visually the suggested files with audio recordings of the 
three species of ungulates using Praat; conduct the tracking and mea-
suring the fundamental frequency and then track the first four for-
mant frequencies in the indicated calls. The results of the conducted 
work (measurements of the fundamental frequency in 10 calls and 
measurements of formant frequencies in 7 calls) should be presented 
in the Excel table.

Step-by-step guide to the work  
with Praat

The Praat software is free. The latest version of Praat can be down-
loaded at link http://www.fon.hum.uva.nl/praat/. Unpack and start the 
program; the special installing is unnecessary. Below, the work with 
files will be described for Praat version 6.1.12.

Creating spectrogram
Start Praat. You will see two windows: Praat Objects (this is the main 

window of the program) and Praat Picture (which can be immediately 
closed, as it will not be used in frames of the current Task 5).

http://www.fon.hum.uva.nl/praat/
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For downloading and visual inspection of the audio file, select from 
menu Read → Read from file. The downloaded file will appear as the 
line in the section «Praat Objects». In the right column, select «View & 
Edit», and you will see the spectrogram of the file in a separate window 
Sound (Fig. 45).

Spectrogram zooming can be made using the keys «All», «Sel», «In», 
«Out», located in the left low angle of the window (sometimes they are 
not visible immediately, then you should extend the window to the en-
tire screen of the monitor):

In — zooming;
Out — deleting;
Sel — extending the window up to the borders of the cursor (marked 

with red dotty vertical lines);
All — show the entire file on the screen;
Bak — cancel the last change (step back);
Under the spectrogram, there are three grey bands for playing back 

the audio file. Pressing the lowest band allows playing back the entire 
file, pressing the middle plays back would play back the visible part of 
the file and pressing the upper one would play back the part of file be-
tween the cursors.

Figure 45. Spectrogram and oscillogram of male red deer Cervus elaphus 
hispanicus calls in the working window Sound of Praat.
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Settings for tracking the fundamental frequency
At file opening, the program applies by default the settings used in 

the last time. However, if the current analysis demands different set-
tings, they should be changed. For doing this, select from menu of the 
spectrogram window «Sound»: View → Show analyses → 50 s. Put a 
checkmark in the checkbox «Spectrogram, pitch». In Praat, the term 
«pitch» encodes call fundamental frequency. Now you will see call 
spectrogram and track its fundamental frequency (drawn in blue col-
or), as on Figure 45.

Further, select from menu of the spectrogram window «Sound» 
View → Time step settings → Fixed, select «Fixed time step» equal to 
0.01 s.

Then select Spectrum → Spectrogram settings from menu of the spec-
trogram window «Sound», select the following parameters:

View range — 0–2000 Hz;
Windows — 0.04 s;
Dynamic range — 60 dB.
Scale of values of the fundamental frequency is shown to the left of 

spectrogram (it varies from 0 to 2000 Hz on Figure 45).
Further, from menu of the spectrogram window «Sound», select 

Pitch → Pitch settings and specify the following settings:
Pitch range — 50–1000 Hz (these values should be set for each file 

separately);
Analysis method — cross-correlation;
Drawing – speckles.
Finally, select Pitch → Advanced Pitch settings from menu of the spec-

trogram window «Sound»: checkmark the box «Very accurate».
Scale of values for the fundamental frequency for «pitch» is shown 

with blue color to the right of spectrogram (50–1000 Hz on Figure 45).

Tracking the fundamental frequency — action steps
1. In the window «Sound», select, with cursor bordering, a fragment 

of sound file, then press «Sel» to zoom this call fragment to the entire 
window.

2. From menu of the spectrogram window «Sound», select Pitch → 
Extract visible Pitch contour (Fig. 46). In the window «Praat objects», 
the window «Pitch untitled» will appear.

3. Press «View & Edit» (in the right column of the window «Praat ob-
jects»). You will see the window «Pitch untitled» with track of the fun-
damental frequency band (Fig. 47).

4. In the window «Pitch untitled», set manually the missing points 
and delete the incorrect points. Inspect visually by spectrogram, which 
points are correct.
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Figure 46. Spectrogram window prepared for tracking the fundamental 
frequency of a male red deer Cervus elaphus hispanicus call in Praat.

Figure 47. Window «Pitch untitled» with track of the fundamental frequency band 
of a male red deer Cervus elaphus hispanicus call in Praat.
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Figure 48. Window «Pitch untitled» with a zoomed track of the fundamental 
frequency band of a male red deer Cervus elaphus hispanicus call in Praat. 
Active values of the fundamental frequency used for the track calculating, 
are shown with pink points.

Figure 49. Window «Praat Info» with calculated values of the obtained track  
of the fundamental frequency band of a male red deer Cervus elaphus hispanicus 
call in Praat.
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To add a new point, press the respective digit; it will become pink-col-
or at activation. For deleting the incorrect point, press the band «Unv» 
below the window, whereas the pink pouring of the digit will disappear 
and the point will become inactive. On the band «Unv», you will see the 
blue color of the inactive time frame.

Zooming the window can be done with keys «Sel», «In», «Out», locat-
ed on the left under the window with track (Fig. 48).

5. For obtaining data from menu of the window «Pitch untitled», se-
lect Query → Pitch info. From the opened window (Fig. 49), copy (us-
ing «Ctrl+C») and paste to the Excel file (you can use the preliminary 
prepared file Praat.xls) the following values: «Minimum», «Maximum», 
«Range», «Average».

The Praat provides descriptive statistics only in the textual format. So, 
it is necessary to manually copy the values and re-distribute them to the 
respective cells of the table (Praat.xls, page «Fundamental frequency»).

Practical work on tracking the fundamental frequency
Please, measure the four values of the fundamental frequency (the 

minimum fundamental frequency — «Minimum», the maximum fun-
damental frequency — «Maximum», the depth of frequency modula-
tion — «Range», the average fundamental frequency — «Average») for 
10 calls of the three species (each call is in a separate file, the list of 
files is provided below) in Praat, and introduce the data of measure-
ments in the file Praat.xls on the page «Fundamental frequency». Files 
with calls for analysis and the Excel table are available at link http://
bioacoustica.org/practicum/practicum_eng.html. On the page «Funda-
mental frequency» the necessary actions (column «Additional Actions») 
on correcting (editing) the track of fundamental frequency in the win-
dow «Pitch untitled» are indicated.

The list of audio files for tracking and measuring fundamental fre-
quency and additional settings «Pitch range» (which should be set be-
fore the beginning the work with each file separately in menu of the 
spectrogram window «Sound» using Pitch → Pitch settings → Pitch 
range) for each file:

File name Pitch range (Hz)

C_elaphus_hippelaphus_1.wav 50–500 

C_elaphus_hippelaphus_2.wav 50–500

C_elaphus_hispanicus_1.wav 50–500

C_elaphus_hispanicus_2.wav 50–500

C_elaphus_sibiricus_1.wav 100–2000

http://bioacoustica.org/practicum/practicum_eng.html
http://bioacoustica.org/practicum/practicum_eng.html
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File name Pitch range (Hz)

C_elaphus_sibiricus_2.wav 100–2000

C_elaphus_sibiricus_3.wav 100–2000

Gazella_subgutturosa_1.wav 20–200

Saiga_tatarica_1.wav 20–200

Saiga_tatarica_2.wav 20–200

Program settings for tracking the formant frequencies
For preparing the program for tracking the formant frequencies of 

the calls, delete the fundamental frequency track from the spectrogram 
window: in menu of the spectrogram window «Sound» select «Pitch» 
and delete the checkmark against «Show pitch». Now select from menu 
«Formant» and put the checkmark against «Show formant». The track of 
fundamental frequency will disappear and the red formant tracks will 
appear.

Select from menu of the spectrogram window «Sound» Spectrum → 
Spectrogram settings and set the working range for creating the tracks 
of the formant frequencies (now you can set the range 0–5000 Hz, but 
this range should be set for each file separately).

Then select from menu of the spectrogram window «Sound» For-
mant → Formant settings and set the following parameters for calculat-
ing the formant tracks:

Maximum formant — 4200 (will be set for each file separately);
Number of formants — 4 (for all files of the given task this parameter 

remains unchanged, but in reality, it can substantially differ between 
species depending on their specific morphological traits);

Window length — 0.04 s;
Dynamic range — 30 dB;
Dot size — 2 mm (Fig. 50).

What you should know for the correct selecting the settings for calculat-
ing the formant frequencies?

What are the values which we established in the fields «Maximum 
formant» and «Number of formants» and why they should be tuned for 
each species and call type separately for the correct tracking and mea-
suring the formant frequencies? The parameter named as «Maximum 
formant» represents the upper (maximum) border of frequency range, 
in which the calculation of formant frequencies will be done. «Number 
of formants» means the number of formants (in units), which can be 
within limits of this frequency range. That is, if «Maximum formant» = 
4200 Hz, and «Number of formants» = 4, this means, that you want 
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to calculate the values of the four formants within range from 0 to 
4200 Hz. Why we selected here these settings and why they are so im-
portant for conducting the correct analysis?

The values of formant frequencies depend, in the first order, on the 
length of the vocal tract and (for the one-end closed tube) can be rough-
ly calculated by formula Fn=(2n-1)*C/4L, where n — the formant num-
ber, C — sound speed (in moist warm air, approximately 350 m/s), L – 
the vocal tract length. That is, the longer is the vocal tract, the lower 
are the values of the formant frequencies. So, before the start of mea-
suring formants in the calls, you should know (at least approximately) 
the length of the vocal tract of individuals of the given species, sex and 
age, in order to understand at which frequencies should be posed the 
formants in animal subjects of your study and to select correctly the set-
tings for «Maximum formant» and «Number of formants» at calculating 
the tracks of the formant frequencies.

However, determining vocal tract length is not so easy. In particular, 
you should to take into account, that mammals can vocalize through the 
mouth and through the nose (in mammals, the nasal vocal tract length 
is always longer than the oral). In addition, transits from the nasal to 
oral emission or back can occur within a call. Moreover, some mammals 
can elongate the vocal tract length during the calls, by retracting the 
larynx down or by extending the nasal trunk. So, the anatomical-based 

Figure 50. Spectrogram window prepared for tracking formant frequencies in 
goitred gazelle Gazella subgutturosa call in Praat.
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Figure 51. The lengths of the oral vocal tract (blue line) and of the nasal vocal tract 
(red line) of female saiga Saiga tatarica, obtained at conducting the anatomical 
dissection. A position of the vocal folds is marked in green. Scale bar is 10 mm. 
Taken from Volodin et al. 2014.

Figure 52. The lengths of the oral vocal tract length (blue line) and the nasal 
vocal tract length (red line) of saiga newborn calf Saiga tatarica, obtained using 
computer tomography. Position of the vocal folds is marked in green. Scale bar  
is 10 mm. Taken from Volodin et al. 2014.
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measurements of the vocal tract length can be insufficient and therefore 
the visual observations and even video recording of vocalizing animals 
can be necessary for understanding whether the calls are produced 
through the nose or through the mouth and how the vocal tract length 
changes during a call.

Below, we provide some examples of how the measurements of the 
vocal tract lengths of different species were obtained.

1. Saiga Saiga tatarica, adult female vocal tracts were measured 
at conducting the anatomical dissection. The oral vocal tract length 
(Volodin et al. 2014) is 240 mm, the nasal vocal tract length 320 mm 
(Fig. 51).

2. Saiga Saiga tatarica newborn. Vocal tracts were measured using 
computer tomography (Volodin et al. 2014). The vocal tract length is 
116 mm, the nasal vocal tract length is 142 mm (Fig. 52).

3. Adult male red deer of the Central European subspecies Cervus ela-
phus hippelaphus. Vocal tracts were measured at conducting frame-by-
frame video analysis along to skull measurements and reconstructions 
of skull positions (Volodin et al. 2019). The average skull basal length 
is 372 mm, the oral vocal tract length in resting position is 562 mm, the 
oral vocal tract length during vocalization is 800–810 mm (Fig. 53).

Tracking formant frequencies: sequence of actions
Download the audio file and create its spectrogram. In the opened 

window «Sound» select the audio file fragment which you want to anal-
yse, then press the key «Sel» to expand the spectrogram to the entire 

Figure 53. Calculated basal skull length (blue line) and the oral vocal tract length 
(yellow line) at rest (a) and during vocalization (b) of a male red deer Cervus 
elaphus hippelaphus, obtained at conducting video frame-by-frame analysis, 
as well as skull measurements and reconstruction of skull position. Taken from 
Volodin et al. 2019.
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Figure 54. Spectrogram of a goitred gazelle Gazella subgutturosa call with tracks 
of the four formant frequencies and with opened panel for setting the parameters 
of formant frequencies in Praat.

Figure 55. Spectrogram window displaying a goitred gazelle Gazella subgutturosa 
call with tracks of the four formant frequencies, with opened windows «Praat 
objects» and «Formant List» in Praat. Parameters for tracking the formants 
correspond to their description in the text.
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window (for each file, rely on time marks «time1» and «time2» on the 
page «Formants» in the file Praat.xls).

Select from menu: Formant → Extract visible formant contour (Fig. 54).
In the window «Praat objects», the line «Formant untitled» will ap-

pear. Then select «Tabulate», then select «List» (in the right column of 
the window «Praat objects»). The window «Formant List» will open. Put 
the checkmark only against «Include time» and «Include number of for-
mants», leave other fields unmarked (Fig. 55). Press «Ok».

The window «Praat info», with the necessary information on the cal-
culated tracks of formant frequencies will open (Fig. 56).

Mark all data with cursor, copy them and insert in the file Praat.xls, 
page «Temp». At this page, two data volumes are generated, for the 
small (yellow) and large (brown) number of values. Insert the copied 
from «Praat info» data volume to the cell «time(s)» and mark it with 
cursor.

In the copied values, replace the decimal point with comma («Praat 
info» provides the values in which the decimal sign is the point). For 
doing this, select in Excel Edit → Change, and introduce the respective 
symbols; press «Change all». As the result, we receive the time marks 
indicating the real time of this mark in the audio file and the values 
of each formant in each time window. Besides this, below the volume, 

Figure 56. Spectrogram window displaying a goitred gazelle Gazella subgutturosa 
call with tracks of the four formants and with opened windows «Praat objects» 
and «Praat info» in Praat. Parameters for tracking the formants correspond to their 
description in the text.
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the average value for each column will be automatically calculated, that 
is, we will obtain the average values of the four formant frequencies 
(F1-F4) all over the track on the analysed call section.

Then, copy the average values of the formant tracks and insert them 
by selecting Special insert → Values) to the page «Formants» of the file 
Praat.xls.

Tracking formant frequencies — practical work
In frames of this task, you should measure (with Praat by tracks), the 

values of the first four formants for each of the 7 calls (each call is in a 
separate file, the list of the files is provided below) and introduce data 
of the measurements to the file Praat.xls on the page «Formants».

On the page «Formants», the borders for each call are indicated (in 
seconds, «time1» and «time2»), in which you should conduct the mea-
surements of the formant frequencies (the borders for the measure-
ments should be set with cursor in the spectrogram window «Sound», 
then press «Sel» and further follow to the above given description). 
Files with calls for analysis and the Excel table are available at link 
http://bioacoustica.org/practicum/practicum_eng.html. Examples of 
the correct positions of the tracks of the nasal and oral formant fre-
quencies on spectrograms of saiga calls Saiga_tatarica_3.wav are 
shown on Figure 57.

Figure 57. Positions of tracks of the first four formants of saiga Saiga tatarica calls, 
calculated for the nasal part (a) and the oral part (b) of the same call.

http://bioacoustica.org/practicum/practicum_eng.html
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The list of the audio files for tracking and measuring formant frequen-
cies and additional settings «Spectrogram settings» and «Formant set-
tings» (which should be established before the start of the work with 
each file manually via «Spectrogram → Spectrogram settings» and «For-
mant → Formant settings») for each file:

File name Spectrogram settings Formant settings

Gazella_subgutturosa_1.
wav

0–5000 Hz Maximum formant 4200
Number of formant 4

Gazella_subgutturosa_2.
wav

0–5000 Hz Maximum formant 4600
Number of formant 4

Gazella_subgutturosa_3.
wav

0–6000 Hz Maximum formant 5200
Number of formant 4

Saiga_tatarica_1.wav 0–8000 Hz Maximum formant 6200
Number of formant 4

Saiga_tatarica_2.wav 0–5000 Hz Maximum formant 3100
Number of formant 4

Saiga_tatarica_3.wav nasal 
part

0–5000 Hz Maximum formant 2300
Number of formant 4

Saiga_tatarica_3.wav oral 
part

0–5000 Hz Maximum formant 3400
Number of formant 4
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Task 6.
Recording animal vocalizations 

for bioacoustical studies: choice of 
equipment and main rules for call 

collection under the field conditions

Study objects

Study objects can be any highly vocal species of mammals and birds 
(as many as possible), producing calls within human hearing range. The 
best place for conducting the practical training is a zoo.

Aims of the work

1) to collect audio recordings of as much as possible number of mam-
mal and bird species, with detailed comments and descriptions in a pa-
per diary followed with copying to electronic table;

2) to conduct a visual inspection of the obtained audio recordings and 
to make a short description of each recorded audio file.

Introduction. Choice of equipment  
for audio recording

Applying the bioacoustical approach in zoology
In the last decades, the applied aspects of bioacoustical studies develop 

actively, both in the field and in captivity. In captivity, bioacoustics ap-
proaches are applied for estimating animal reproductive state (e.g., in zoo 
felids for determining time for pairing, in farmed cows, for determining 
the moment of artificial insemination); for determining and correcting the 
degrees of discomfort in farmed animals (including the automatic acous-
tic detection), for sexing bird species without external sexual dimorphism 
and for developing the methods of individual acoustic monitoring. In the 
field, the bioacoustical approaches are used for searching the individual 
(group) markers in voice and monitoring “known” individuals or groups 
during the annual life cycle or from season to season; for playing back 
the recordings for luring and censuses of animals and determining their 
individual tags. Automated audio recording can be used for determining 
animal species composition and its changes throughout many years, as a 
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rule, by applying the automatic systems for call recognition, as well as for 
estimating biodiversity, estimating landscape quality and estimating the 
degree of habitat degradation (ecoacoustical approach).

Recording calls for conducting bioacoustical studies can be done 
manually or automatically. In the first case, a researcher can observe, 
in which situations the animals produce these or those calls and see 
which individual is calling (and can, therefore, to identify individuality, 
sex, age and other parameters of the focal animal), regulate the level of 
recording, actively change the distance to the focal animal. However, 
researcher’s presence potentially affects animal behaviour, so, in some 
cases, animals (even tolerate to humans farmed animals) can change or 
even stop the normal behavioural activity. Moreover, animals can vo-
calize only time to time (for example, at night or irregularly, with large 
intervals), what makes the manual recording difficult. In such cases, 
the automated recording is preferable, using different automated audio 
recorders (SongMeter, Audiomoth, Audiolog and others). With auto-
mated recording, it is possible to obtain a large massive of high-qualita-
tive calls, because animals, in this case, do not afraid of human presence 
and vocalize in vicinity of recording equipment; however, identifying 
individuals from the automated recordings is impossible. Automated 
recorders allow conducting audio recording by predetermined schedule 
for periods up to a few months in the autonomous mode. Such record-
ers are very solid and water-proof. With help of automated recorders, it 
is possible to track species’ vocal activity in dynamics for prolonged time 
periods (for example, to track the dynamics of rutting vocal activity). 
However, using such devices, a researcher should keep in mind, that 
then a lot of time should be spent for visual inspection of the audio files 
and searching the recorded calls of the focal species.

Equipment for audio recording
Equipment for audio recording includes a portable recorder and mi-

crophone. In the last years, in relation to progress of digital audio re-
cording, the classical tape and cassette recorders became completely 
out of use. Currently, audio recording is primarily made using porta-
ble digital recorders with memory cards. Digital recorders immediately 
transform the calls to audio files and store them on the memory cards, 
emancipating the researcher from the need to digitize the collected ma-
terial. Furthermore, digital recorders have not any movable parts, what 
makes them more reliable.

Digital recorders for field recording should be portable and well-de-
fended from environmental impact, because they should work at vari-
ous temperatures and moisture as well as at the wind, and periodically 
resist against quite strong mechanical shocks. Control must be carried 
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out by mechanical buttons; sensory panels are inappropriate, as they 
are capricious and poorly visible in the sun. Recorders should be con-
trolled with one hand; the number of control buttons should be minimal 
(ideally, only three — Record, Pause, Stop); they should be positioned 
comfortably under the fingers of a hand. It is better to use batteries or 
rechargeable batteries, as built-in storage batteries cannot be charged 
during long trips (because during the day you work, whereas at nights, 
there is no sun for charging the devices).

Field recorders should obligatorily have a possibility of manual regu-
lation of recording level, which allows to take into account the intensity 
of caller vocalizations. Automated regulation of recording level, occur-
ring on non-professional recorders and smartphones is inappropriate, 
as, in this mode, a recorder tunes itself for the loudest calls (as the wind, 
transport noise, loud calls of other animals), smoothies the differences 
between different call parts, and aligns the entire recording by intensity.

At selection of recorder, pay attention on the very convenient function 
of prerecording, which enables to record calls emitted a few seconds be-
fore the real start of recording. This function is especially convenient for 
recording animals, producing calls rather rarely, for example one time 
per 5–15 minutes. Using prerecording, you can be «on pause» during in-
tervals between calls, turning on recording only at the moment of call-
ing activity. In this case, the prerecording function, from one side, will 
not give you to miss the first seconds of vocalization, and from another 
side, you should not waste the memory and power for recording the 
long silent spaces between calls.

It is important to pay attention on the range of frequencies covered by 
recorder. All modern digital recorders qualitatively record calls in a broad 
range of frequencies, at least up to 24 kHz. But if you plan to work with 
animals using the ultrasonic range of frequencies (for example, with bats 
or rodents), this range is insufficient. Anyway, mind that the working fre-
quency range of recorder corresponds to the half of the maximal value of 
sampling range, that is, at sampling rate 48 kHz, recorder will collect the 
calls at frequency range up to 24 kHz, at sampling rate 96 kHz recorder 
will collect the calls at frequency range up to 48 kHz etc. However, dou-
bling sampling rate will increase twice the volume of the audio file. So, 
before the start of recording, it is necessary to select the working range of 
frequencies of recorder (sampling rate) correspondingly to the maximal-
ly possible frequencies of calls of the study animal species.

The recorder should have the option for recording calls in non-com-
pressed format (to form the files with extension *.wav). This allows 
further conduct a detailed analysis of call acoustic structure, because 
the professional spectrographic programs, as a rule, do not work with 
compressed audio files (with extensions *.mp3 and similar).
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It is recommended to use the recorders with professional acoustic 
ports for connecting microphones (XLR), as they provide the reliable 
fixation and low level of noise. The more simple ports (JACK) are com-
monly destroyed fast and can damage the recording by adding the un-
pleasant acoustic background (noise).

Mechanical reliability of buttons on the working panels is also im-
portant. The buttons should tolerate the permanent changes of working 
modes, weight of recorder and amount of used energy.

For outdoor recording, the following recorders are currently avail-
able: Zoom (H1, H4, H5, H6); Marantz (PMD-660, PMD-661, PMD-
671); Tascam HD-P2; Fostex FR-2. For recording the ultrasonic calls, 
there are portable recorders Pettersson D1000X, Echo Meter Touch2 
Pro. The Echo Meter Touch2 Pro allows conducting visualization of au-
dio recording in live mode (showing the spectrograms of ultrasonic calls 
on the smartphone display), what is very convenient for the research-
ers, as ultrasonic calls are inaudible and therefore researchers cannot 
control the audio recording process by ear. Important, that new models 
of recorders appear each year, so, it is better to buy them not «for the 
future», but for the current particular task.

Unlike recorders, microphones update much more rarely and can 
serve 10 years or more. Microphones, by their construction, can be sub-
divided to the dynamic and condenser microphones. The dynamic mi-
crophones are simpler constructively and therefore cheaper and more 
reliable during the work; whereas the condenser microphones allow 
recording fainter calls and higher-frequency calls. The upper border of 
the nominal frequency range of microphone (that is, frequency range, 
in which the microphone minimally distorts the recorded calls) should 
be, as a rule, not below 15–20 kHz.

For different tasks, microphones with different «sensitivity» and di-
rectionality should be used. For recording intense calls at close distance 
(dog barking), weakly-directional (cardioid) microphones with sensitiv-
ity of about 2 mV/Pa are appropriate, whereas for recording faint calls 
at a remote distance (e.g., contact calls from the red deer herd), direc-
tional, highly sensitive microphones should be used, with sensitivity at 
least 30–40 mV/Pa. Below, you can find the list of relatively inexpensive 
microphones in the order of increasing their sensitivity and directional-
ity: Sennheiser-е845 (dynamic); AKG-C1000S; Audiotechnica AT-835B; 
Sennheiser K6-ME-66 and Sennheiser K6-ME-67 (condenser).

Conducting audio recording
In some aspects, audio recording of animal calls is similar with pho-

tographing: whereas many people have good photo cameras, much ef-
fort is necessary in order to make a good photo. The general principle 
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is simple: the closer is the animal, the higher-qualitative calls you can 
record. But during recording, you should minimally affect the animal 
behaviour. If it is impossible to approach secretively (e.g., in the open 
steppe, desert, tundra), you can use the automated recorders as remote 
microphones. In places of animal concentration, researcher can estab-
lish the automated recorders for the continuous recording and observe 
from a few hundred meters or depart if the animals continue to react 
to a human. During recording in captivity, the distance should not be 
too close, as at very close distance (e.g., less than 0.5 m for a not large 
animal of fox size or less than 0.3 m for a rodent of a ground squirrel 
size) animal breathing can also be recorded and substantially distorts 
the audio file.

Before starting the recording, select preliminary, in the pause mode, 
the approximate level of recording, corresponding to the intensity 
of calls of the focal animal. Indication on the panel of recording lev-
el should display that target calls will be recorded without distortion 
(overloading), with a high, but not too high, level of recording. That is, 
the indication of recording level should be within the green field and 
do not come to the red field. The recording made with overloading is 
scrap, such recordings have a destroyed structure and can only be used 
very restrictively.

If it is impossible to qualitatively record the series consisting of calls 
strongly differing in intensity, you should make two recordings one af-
ter another. During the recording, you can initially ignore the quality 
of faint calls, by using for recording the low level of recording; then, 
you can record qualitatively the faint calls at high level of recording, 
with the exceeding level of recording for the intense calls. In the first re-
cording, faint calls will be practically inaudible, whereas in the second 
recording, faint calls will be recorded normally, whereas intense calls 
will be recorded with overloading.

During recording, researcher should observe behaviour of a caller, 
and, when necessary, comment it, trying to put the comments during 
the intervals between calls. For this, in some cases, you can use the 
stereo recording, where the animal calls are recorded to one channel, 
whereas the researcher’ comments are recorded to another channel. 
For recording the voice comments, in this case you can use loop micro-
phone, fixed on clothes, whereas the main microphone for recording 
would be better to locate distantly on the long cord, closer to the focal 
individual.

The comments should also include information about all changes of 
the mode of recording (level of recording, distance to the animal, its ori-
entation relative to microphone, location of researcher). In cases when 
a few animals vocalize simultaneously or the recording is too noisy, 
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each call of the focal animal caller should be commented by voice (for 
example, at call-over or duet of two animals, using the words «first – 
second» / «male — female» / «parent — offspring / «call» etc.). After 
ending the recording, it is necessary to make the expanded commentary 
(«label»), which should include the place, date and time of recording, 
animal species, individual, distance, orientation of the focal individual 
to microphone, situation and behaviour of the focal animal, presence of 
other individuals etc.

Introducing some noisiness during the recording is unavoidable, how-
ever, it should be kept at minimum. As a microphone records well even 
very weak mechanical oscillations, for excluding the interferences, you 
should avoid the touches by the microphone to any objects (wire mesh, 
branches, grass). Fingers keeping the microphone should be immobile. 
The microphone cord should not be dragging on the ground or touch 
any objects. Always use the windproof (especial foam head, which is in 
complect of any qualitative microphone). However, in windy weather, 
would be better do not conduct the recordings at all, without the ex-
treme need (distortions are unavoidable), if it is necessary, the micro-
phone should be shield-proofed against wind, at least by own body, and 
the recording should be longer, with hope that at least some calls will be 
recorded between wind gusts.

Batteries should be kept separately from the recorder or condenser 
microphone and attached to the equipment immediately before the 
work. This will allow to avoid damaging the equipment by the electro-
lyte occasionally leaking from the strongly used batteries. During re-
cording at a negative temperature, the power cells can discharge very 
fast, so you will need two complects of batteries used alternately, one in 
the recorder, another one is heating inside clothes. Otherwise, you can 
use the external power cell kept inside clothes. If the recorder is small in 
size, it can be kept inside clothes, by hanging around your neck, so that 
only the external microphone on the cord was outside.

Researcher should avoid the rustling synthetical clothes, because they 
produce intense sounds with spectrum up to 40–50 kHz at arm and leg 
movements. These noisy clouds can overlap entirely the target calls. In 
addition, many animals hear in the ultrasonic range (for example, do-
mestic dogs hear up to 41–47 kHz, Heffner, 1983) and therefore can 
behave unnaturally.

When you go to collect the calls, take with you an additional com-
plect of fresh batteries or accuses and the additional memory cards. 
There is a probability that batteries will be discharged at the most in-
teresting moment of recording, or a well-familiar animal will start vo-
calizing somehow unusually, or just something other interesting thing 
will occur.
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Same-day processing and storage of audio recordings
Audio files with recordings of animal calls should be copied from 

the memory cards to computer. During the multi-day call collecting in 
the field, the collected recordings should be visually inspected using a 
spectrographic program in the evening of the same day. This provides 
researcher’s feedback, allowing to adjust the distance to the animal call-
ers and the settings for recording their calls in the next day. Moreover, 
you will immediately obtain the impression regarding the real num-
ber of well-recorded calls: you can think that you recorded many calls, 
whereas in reality you may see, for example, that 90 % of the calls are 
broken with the wind.

Ideally, the audio files should be re-named and sorted by the folders 
correspondingly to animal species. Detailed data regarding the mode and 
conditions of recording with all comments should be copied from the dia-
ry to the electronic tables. As a rule, the full passport of recording contains 
the name of the audio file; date and time of recording; caller species, sex; 
age, maybe name; call type and context of emission; level of recording and 
the distance to the animal; place of recording; weather; call collector (re-
searcher) name. For better storage of the audio files, their copies should 
be stored also on other computers and other external digital storages.

Task for the practical work

Please, conduct the audio recording of the calls of the vocally active 
species of mammals and birds. During the recording, keep in mind the 
following things:

1. For each situation, please select the particular level of recording 
(desirably, it should be done when the recorder in «pause» mode).

2. Do not forget about the «label» for each file (comment with voice 
the place, date, species, individual, situation, behaviour and other ad-
ditional information when necessary), it is convenient to do this at the 
end of the file, when recording of target calls is ended.

3. Comment for the duration of the recording, labelling the calls with 
voice (this way, it will be easier to find them and to distinguish them 
from the alien noise and calls of other individuals).

4. Do not forget about the defence of the equipment against rain and 
wind.

5. After conducting each recording, put on a comment to the field di-
ary, with indicating the file (files) name, their duration, animal species, 
individual, distance, orientation of the individual caller to microphone, 
other conditions of recording, situation and behaviour, presence of con-
specifics and other interesting things if necessary.
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6. Do not forget to take with you the extra batteries and memory cards.
After conducting the recording, please copy the collected audio files 

to your own computer. Inspect visually the collected recordings, esti-
mate the quality of the recorded calls, make up a catalogue of the re-
cordings (fill the Excel table with indicating the date, time, author or 
the recording, used equipment, ordering numbers of recordings, du-
ration of recording, vocalizing species during the recording, approxi-
mate numbers of recorded calls, situations and comments for each file). 
Please conduct the work over the mistakes, by discussing the made mis-
takes at conducting the recordings and think how they can be avoided 
in the future.
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